PRESERVING LAND WITHIN RILEY COUNTY AND MANHATTAN, KANSAS: 
CONSERVATIONIST AND DEVELOPER APPROACHES TO LAND PLANNING

By

JOSHUA C. FARLEY

A REPORT

submitted in partial fulfillment of the requirements for the degree

MASTER OF LANDSCAPE ARCHITECTURE

Department of Landscape Architecture/Regional and Community Planning
College of Architecture, Planning, and Design

KANSAS STATE UNIVERSITY
Manhattan, Kansas

2013

Approved by:

Laurence A. Clement, Jr.
Major Professor
Copyright
JOSHUA C. FARLEY
2013
Abstract

Increasing population in Manhattan, Kansas and rising enrollment at Kansas State University have increased the interest in establishing new residences and commercial businesses within the city limits. Locations for development include the revitalization of Manhattan’s south end and sites adjacent to Seth Child Road, US Highway 24, and K-177. Recent development patterns in Manhattan, such as residential development near Wildcat Creek, have resulted in severe environmental impacts. While most development enhances existing land use patterns, undeveloped natural areas along K-177 present several environmental opportunities and restraints that must be assessed and well-planned for to accommodate projected growth in a sustainable way.

Topography, existing vegetation, drainage networks, wildlife habitats, and proximity to the Kansas River contribute to limitations in development along and extending from K-177. This proximity and resulting development could reduce existing wildlife habitat, plant species, and the overall health of Manhattan’s and the surrounding area’s air, soil and water quality. Developmental strategies are needed to ensure the conservation of sensitive ecosystems and to direct development to the most suitable areas. After conducting an inventory of the land’s natural resources and land use patterns, two suitability models were created to express areas most suitable for development based on two sets of values; conservation-minded and developer-minded. As sites for development were located and assessed, a trail suitability model was then created to express potential connections between new and old development and to show links to other significant destinations. This trail system also establishes greenway selection criteria, aiming to further protect remaining natural areas while providing a public amenity.

Fulfillment of the goals and objectives of the Gateway to Manhattan Plan (GMP), establishes development suitability through a conservationist approach to ensure significant preservation of land. Such an approach and related conservation strategies are then discussed to act as a platform for decision making as lands along K-177 are developed. The trail suitability study and proposed greenway network provide solutions for meeting the GMP’s goals of establishing multi-modal connectivity along and across K-177 while conserving environmental resources. In addition to controlling development patterns, these greenways will act as conduits for wildlife, help maintain or enhance air, soil and water quality, protect endangered flora and fauna, and provide recreational amenities while minimizing overall negative environmental impacts.
PRESERVING LAND WITHIN RILEY COUNTY AND MANHATTAN, KANSAS
CONSERVATIONIST AND DEVELOPER APPROACHES TO LAND PLANNING
Joshua Farley  I  MLA Project and Report  I  Spring 2013
Table of Contents

<table>
<thead>
<tr>
<th>i</th>
<th>Title Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ii</td>
<td>Copyright</td>
</tr>
<tr>
<td>iii</td>
<td>Abstract</td>
</tr>
<tr>
<td>iv</td>
<td>Cover</td>
</tr>
<tr>
<td>v</td>
<td>Table of Contents</td>
</tr>
<tr>
<td>vi - vii</td>
<td>List of Figures</td>
</tr>
<tr>
<td>viii</td>
<td>List of Tables</td>
</tr>
<tr>
<td>ix</td>
<td>Nomenclature</td>
</tr>
<tr>
<td>x</td>
<td>List of Supplemental Files</td>
</tr>
<tr>
<td>xi</td>
<td>Acknowledgments</td>
</tr>
<tr>
<td>xii - xvii</td>
<td>Preface</td>
</tr>
</tbody>
</table>

**Chapter 1 - Project Introduction**

| 2 | Dilemma |
| 3 | Stakeholder Values |
| 4 | Research Questions |
| 4 | Thesis |
| 5 | Flint Hills Ecoregion |
| 6 | Study Area Location and Size |
| 7-9 | Study Area Photos and Character |
| 10-11 | Planning Context and Corridor Considerations |
| 12-13 | Study Goals and Future Strategies |

**Chapter 2 - Background**

| 16 | Literature Map |
| 17-20 | Literature Review |
| 21-26 | Precedent Studies |
| 27-29 | Research Summary and Findings |

**Chapter 3 - Methods**

| 32-33 | Methodology Diagram |
| 34-51 | Study Area Inventory |
| 52 | Analysis Criteria |
| 53-55 | Developer Approach |
| 56-58 | Conservationist Approach |
| 59 | Selection of Focus Parcels |
| 60 | Comparing Alternative Plans |
| 60-62 | Viewshed Overlay |
| 63-65 | Trail suitability |

**Chapter 4 - Results**

| 68-69 | Alternative One - Developer Approach |
| 70-71 | Alternative Two - Conservationist Approach |
| 72-73 | Trail Suitability |

**Chapter 5 - Conclusions**

| 76-78 | Comparing Alternative Development Plans |
| 79-81 | Trail Network and Greenway Planning |
| 82-83 | Assessment of Project Goals |

**Chapter 6 - Further Research**

| 88-91 | Further Research |

**Works Cited**

| 94-95 | Works Cited |
| 96-101 | Figure Sources |

**Appendices**

| 104-106 | Appendix A - Ecotourism - Annotated Bibliography |
| 107-115 | Appendix B - GIS Analysis |
| 116-119 | Appendix C - Contacts and Associated Organizations |
List of Figures

Figure 1. Process diagram ........................................... xiv - xv
Figure 2. Future land use map (http://www.rileycountyks.gov) ............................................... 2
Figure 3. Manhattan’s westside development patterns (Google Maps) ........................................... 3
Figure 4. Northern development patterns adjacent to Big Blue River (Google Maps) ......................... 3
Figure 5. Stakeholder value diagram ......................................................................................... 3
Figure 6. Generalized physiographic map of Kansas (http://www.kansasnativeplantsociety.org/ecoregions.php) .......................................................... 5
Figure 7. Regional map and location (Google Maps) ................................................................. 6
Figure 8. Study area and context ............................................................................................... 6
Figure 9. Commercial core billboards affecting natural character .................................................. 7
Figure 10. K-177 commercial core character .............................................................................. 7
Figure 11. Panoramic view of the K-177 corridor ....................................................................... 7
Figure 12. Vacant parcel within commercial core and adjacent to K-177 ....................................... 7
Figure 13. Residential development - Standel Road ................................................................... 7
Figure 14. Potential road access from Johnson Road .................................................................... 8
Figure 15. Vacant parcel along Crestline Drive .......................................................................... 8
Figure 16. Agricultural lands adjacent to Messenger Road ........................................................... 8
Figure 17. Crestline Drive ........................................................................................................... 8
Figure 18. Rural road character - K Lane .................................................................................... 8
Figure 19. Existing trail near major powerline ........................................................................... 8
Figure 20. Equestrian presence within K-177 corridor ................................................................ 9
Figure 21. Wooded trail within study area .................................................................................. 9
Figure 22. Ridgetop panorama .................................................................................................... 9
Figure 23. Uncontrolled growth of eastern red cedar ................................................................ 9
Figure 24. Ridgetop trail within study area .................................................................................. 9
Figure 25. Kansas State University substation along highway 24 .................................................. 10
Figure 26. Development on ridgetop - Manhattan’s westside ...................................................... 10
Figure 27. Kansas State University substation from highway 13 .................................................. 10
Figure 28. Development surrounding Wildcat Creek (Google Maps) .......................................... 11
Figure 29. Development abutting Wildcat Creek (Google Maps) ............................................... 11
Figure 30. Literature map .......................................................................................................... 16
Figure 31. C & O Towpath, Maryland (Little, 1990) ................................................................. 17
Figure 32. Oconee River Greenway, Athens, Georgia (Little, 1990) .......................................... 17
Figure 33. McMullen Creek Greenway, Charlotte, North Carolina (http://www.tricharlotte.com) .......................................................... 17
Figure 34. Flint Hills Initiative (http://www.nature.org) ............................................................. 18
Figure 35. Red Hills Initiative (http://www.nature.org) ............................................................. 18
Figure 36. Gateway Plan focus area and boundary (http://www.rileycountyks.gov) .................... 20
Figure 37. Commercial development character - Grand Mere Village Manhattan, Kansas .......... 20
Figure 38. Urban residential townhomes (http://www.theneighborhoodsnh.com) .................... 20
Figure 39. Regional map (Gustanski and Squires, 2000; Stark, 1995) ........................................ 22
Figure 40. Land ownership (Gustanski and Squires, 2000; Stark, 1995) ..................................... 22
Figure 41. Regional map (http://www.thewoodlands.com) .......................................................... 24
Figure 42. Greenspace map (http://www.thewoodlands.com) .................................................... 24
Figure 43. Townhome character of the Woodlands (http://www.thewoodlands.com) .................. 24
Figure 44. Regional map (Gustanski and Squires, 2000; Brown, 1987) ....................................... 26
Figure 45. Methodology diagram ............................................................................................... 32 - 33
Figure 46. Land ownership by type ............................................................................................. 37
Figure 47. Land zoning by type ................................................................. 38
Figure 48. Land cover ........................................................................ 39
Figure 49. Current infrastructure and mapped trails ...................... 41
Figure 50. Slope .................................................................................. 42
Figure 51. Aspect ................................................................................ 43
Figure 52. Soils .................................................................................... 45
Figure 53. Flow direction and flow accumulation tools (http://resources.arcgis.com/) .......................................................... 46
Figure 54. Watersheds, drainage, and FEMA floodplain .............. 47
Figure 55. Rare species and protected areas ................................. 49
Figure 56. Viewshed ......................................................................... 51
Figure 57. Stakeholder value diagram .............................................. 52
Figure 58. Developer values ................................................................. 53
Figure 59. Developer’s suitability ....................................................... 54
Figure 60. Developer’s suitability clipped to 1120 contour ............. 55
Figure 61. Conservationist values ...................................................... 56
Figure 62. Conservationist’s suitability ............................................. 57
Figure 63. Conservationist’s suitability clipped to 1120 contour .... 58
Figure 64. Parcel selection ................................................................. 59
Figure 65. Developer’s suitability with viewshed overlay ............. 61
Figure 66. Conservationist’s suitability with viewshed overlay ....... 62
Figure 67. Trail suitability factors ...................................................... 63
Figure 68. Trail suitability with mapped existing and potential trails 64
Figure 69. Trail relationship to public and private lands ............... 65
Figure 70. Alternative 1 - Developer approach ............................... 69
Figure 71. Conventional zoning - Randall Arendt (http://www.dem.ri.gov) ................................................................. 69
Figure 72. Conventional development - Randall Arendt (http://www.landchoices.org) ......................................................... 69
Figure 73. Alternative 2 - Conservationist approach ..................... 71
Figure 74. Conservation zoning - Randall Arendt (http://www.dem.ri.gov) ................................................................. 71
Figure 75. Conservation design - Randall Arendt (http://www.landchoices.org) ................................................................. 71
Figure 76. Existing ridgetop trail with adjacent red cedars .......... 72
Figure 77. Existing trail surrounded by red cedar ......................... 72
Figure 78. Existing trail within utility easement ................................. 72
Figure 79. Existing wooded trail ........................................................ 72
Figure 80. Trail suitability ................................................................. 73
Figure 81. Trail suitability, protected areas, rare species relationships 80
Figure 82. Land bridge and pedestrian bridge potential ............... 81
Figure 83. Vancouver land bridge (http://laud8.wordpress.com) ........ 81
Figure 84. Florida land bridge (http://www.americantrails.org) ...... 81
Figure 85. Concrete Stress Ribbon - Redding, California (http://www.americantrails.org) ......................................................... 81
Figure 86. Wildwood Estates development, roadway, and earthwork plan using AutoCAD Civil 3D .......................... 89
Figure 87. Wildwood Estate entrance view using VUE 9.5 xStream 89
Figure 88. Proposed development and ridgetop roads ....................... 90
Figure 89. Trail suitability and critical viewpoints ......................... 91
Figure 90. Developer values GIS model ........................................... 112-113
Figure 91. Conservationist values GIS model ............................... 112-113
Figure 92. Trail suitability model GIS .............................................. 114-115
List of Tables

Table 1. Developer values .......................................................... 27
Table 2  Conservationist Values .................................................. 28
Table 3. Site inventory factors and relevance to study ....................... 34 - 35
Table 4. Development land cover suitability ratings ........................... 56
Table 5. Trails land cover suitability ratings .................................... 63
Table 6. Ecological, social, and economic benefits of conservation easements .......................... 78
Table B.1 Development land cover suitability ratings .......................... 109
Table B.2 Trails land cover suitability ratings .................................. 111
Nomenclature

Greenway: “I. A linear open space established along either a natural corridor, such as a riverfront, stream valley, or ridgeline, or overland along a railroad right-of-way converted to recreational use, a canal, a scenic road, or other route” (Little, 1990, p. 1). “III. An open-space connector linking parks, nature reserves, cultural features, or historic sites with each other and with populated areas” (Little, 1990, p. 1).

Conservation Easement: “A nonpossessory interest of a holder in real property imposing limitations or affirmative obligations the purposes of which include retaining or protecting natural, scenic, or open space values of real property, assuring its availability for agricultural, forest, recreational, or open-space use, protecting natural resources, maintaining or enhancing air or water quality, or preserving the historical, architectural, archaeological, or cultural aspects of real property” (Gustanski, Squires, & Hocker, 2000, p. 508).

Land Trust: A private, nonprofit organization that works to conserve land by undertaking or assisting in land or conservation easement acquisition (Land Trust Alliance, 2013).

Gateway to Manhattan Plan: Plan devised by Manhattan and Riley County planning boards and staff along with community members to set development goals, objectives, and action plans for the future of lands adjacent to K-177 corridor.

Urban Service Area: “The Urban Service Area generally consists of those areas where basic municipal level services such as sanitary sewer, water and fire protection can be efficiently and economically provided. In the Gateway Corridor, these areas are generally located at or below the 1120 elevation contour” (Riley County Kansas, 2011, p. 2).

Commercial Core: The Gateway Plan designates areas adjacent to K-177 from McDowell Creek Road to approximately Lafayette Drive along with all of the land between K-177 and Stadel Road as the commercial core area (Riley County Kansas, 2011).

Urban Residential: “The portion of the K-177 corridor located outside of the commercial core and below the 1120 foot elevation contour is designated as Urban Residential” (Riley County Kansas, 2011, p. 14).

Overlay District: “The Corridor Overlay District (COD) addresses development in the Urban Service Area and will extend on each side of K-177 to incorporate the Urban Service Area (approximately the 1120 foot elevation and below). The purpose of the COD is to regulate development in this core area along the state highway to promote a more dense development pattern that maximizes the efficient use of the new utility infrastructure improvements, while ensuring quality development that is aesthetically pleasing and compatible with the Gateway area in terms of site development, building and land use standards” (Riley County Kansas, 2011, p. 15).

Ecoregion: “Ecoregions are large areas of similar climate where ecosystems recur in predictable patterns” (USDA, 2013).

Landscape Analysis: A systematic approach of delineating areas with environmental, economic, and social significance in order to create landscape linkages, prioritize conservation, and develop landscape protection strategies.

Natural Resource Inventory/Resource Mapping: Identifying and mapping valuable natural resource assets and ecological features of a region to provide a framework for environmental planning.

Weighted Overlay: “A technique for applying a common measurement scale of values to diverse and dissimilar inputs to create an integrated analysis” (ESRI, 2013).

Landscape Unit Method: Combining individual resources into a common unit that can be easily identified (Gustanski, Squires, & Hocker, 2000).

Magnitude Method: Involves the amount of resources and assessment of priorities based on a quantitative measurement (Gustanski & Squires, 2000). “If for example, the database contained twelve columns of data on wildlife and only one on scenic quality, the results would be heavily weighted in favor of wildlife values” (Gustanski, Squires, & Hocker, 2000, p. 411).

Ecotourism: “Ecotourism is the activity through which the tourist industry, tourists, authorities and local population cooperate for the organization and development of responsible travels to authentic areas in order to admire the ecological richness, to study, understand and enjoy the Nature and the cultural diversity, in a way that does not exploit the resources and that takes into account the environmental impact and support to the activities related the tourist product and to the welfare of the local population, aiming at maintaining the viability in the respective area for an indefinite period of time” (Gruia, 2008, p. 5).
List of Supplemental Files and Programs

Files

Geographic Information System (GIS) data used in this project was derived from the following sources:

   - Elevation_NED30M
   - National Land Cover Dataset
   - Watersheds

2. Kansas GIS - www.kansasgis.org
   - Rare Species
   - Protected Areas
   - Roadways 2010

3. Riley County Data - \maya\LA_TechModule\GIS_SourceData\Source\RileyCounty\RL_GIS_Mar2009
   - Riley County Boundary
   - Manhattan Zoning
   - Manhattan Parcels
   - Churches
   - Buildings
   - Parks
   - Park Trails
   - Floodplains
   - Rivers and Lakes
   - Sewer lines
   - Waterlines
   - Soils
   - Aerial Imagery – 2011

Programs

Geographic Information System (GIS)

A Geographic Information System (GIS) is a tool and software used for capturing, managing, displaying, and analyzing spatial data. GIS allows us to make more informed environmental and land use planning decisions by revealing relationships, patterns, and trends in data. By using this technology as a platform for decision making, understanding and communication among all parties involved is increased while the ability to record and predict change is made more readily available (ESRI, 2013).

Vue 9.5 xStream

Vue is an advanced 3D rendering and animation software used to produce naturalistic environments. By including 3-dimensional models from SketchUp and digital terrain models through GIS, real-time scenes can be created to allow a detailed understanding of existing conditions, significant design elements, and projected future characteristics. Vue 9.5 was used in a previous design project for a 78.4 acre site within the focus area to graphically demonstrate how the site could become a residential development while conserving 40-60% of the land’s natural character. Video fly-throughs are also possible using this software which would allow for a powerful marketing tool to express development and greenway character. This former project, entitled Wildwood Estates will be discussed in the Further Research chapter of this document to express correlations between previous work and elements specific to this master’s report.

Adobe Creative Suite

Adobe InDesign, Photoshop, and Illustrator are all graphic oriented software that were used to create this document and the majority of diagrammatic elements seen throughout. These particular applications within the Adobe software package allow a user to create documents for publication purposes, edit images, and create vector based graphics.
Acknowledgements

Graduate Committee Members

Laurence A. Clement Jr. - Associate Professor, Landscape Architecture/Regional and Community Planning
Howard D. Hahn - Assistant Professor, Landscape Architecture/Regional and Community Planning
Hyung Jin Kim - Assistant Professor, Landscape Architecture/Regional and Community Planning

The completion of this master’s project and report would not have been possible without the time you have invested in me and the amount of help you have provided throughout this process. Your numerous perspectives allowed me to narrow my research and accomplish the goals I set for myself. My sincerest gratitude to all of you.

To my Beloved Family

Lawrence R. Farley, Judith E. Farley, Lawrence R. Farley Jr., & Amanda L. Farley
You are the light of my life and have helped pave the way for my journey and our future together.

To my Fellow Studio Mates and Friends

We have learned such a great deal from each other and have grown together like a family does. It is truly a blessing to know all of you and to have you be a part of my life.

To all the faculty in the Landscape Architecture/Regional and Community Planning Department and throughout the College of Architecture, Planning, and Design

Thank you for continuously challenging me and asking the right questions to make me critically think about the potential impacts of my decisions. Design occurs at all scales, and you have shown me that no matter how small or large a project, design has the ability to impact more than a single client or user. We must seek to meet client needs, provide positive solutions at reasonable scales, and be able to predict how the choices we make will affect the environments in which we live.

To Dereatha Cross, Instructor, Landscape Architecture/Regional and Community Planning

Thank you for going that extra mile when my computer was stolen and helping me locate a comfortable work setting. Your generosity far exceeds your required duties as a professor, and I believe Kansas State University is fortunate to have faculty members such as yourself.

To Christopher Sass, Instructor, Landscape Architecture/Regional and Community Planning

Thank you for your friendship and all your help in the completion of my document and degree. You saw my true potential and continued to push me even when you were not required to do so. Your help in other classes outside of this master’s project have also shaped me as a landscape architect, and I will carry the knowledge that you have given me always.
Throughout my studies in landscape architecture at Kansas State University, I have participated in multiple projects within Kansas State University’s grounds, the City of Manhattan, and surrounding areas. These projects and design assignments included: new visions for McCain Quadrangle, a Seaton greenroof plan, analysis and site design for Marlatt Park, a co-housing development for Girl Scout Park near Sunset Avenue, visions for a Mennonite church and community gathering space along Poyntz Avenue, a Conservation Development sited adjacent to K-177, and a revitalization project for Council Grove’s historic riverfront. My coursework, along with being part of the Manhattan community for five years, has allowed me to get to know the people, the places, and the culture.

As a result, I made a decision that my master’s project and research would be based in Manhattan, seeking to extend the legacy that they, the early settlers and current residents of the community, have created, instilled in me, and fought to protect. The idea of a project based in Manhattan led me to further explore why the town was established, how certain characteristics define the growing city’s unique image, and how we can develop plans to keep this image alive. Major features and attractions of Manhattan include: its location within the Flint Hills region of Kansas; its proximity and placement at the junction of two major rivers, the Kansas and Big Blue; Tuttle Creek Reservoir and State Park; and the Konza Prairie. A project that sought to analyze, enhance, and protect one or more of these major features could benefit the environment, the community, and challenge my own design philosophy.

The previously stated projects, particularly the conservation development project adjacent to K-177, have led to the development of this specific master’s project and report. Because of the proximity of the focus area to the Kansas and Big Blue rivers, the Konza Prairie, and other remaining rural natural lands south of Manhattan, a project of such scope has the ability to express development potential while protecting the natural systems, local character, and responding to the values of potential stakeholders.
Related Courses and Experience

LAR 648 – Specialization Studio, Fall 2011

Through previous site analysis and design development of a 78.4 acre wooded hillside site within the focus area under the instruction of professor Howard Hahn in LAR 648, students collected geologic, geographic, hydrologic, and other site inventory through geodata bases, site visits, and site photography. Using GIS software, a series of maps were created to include: aerial photography, contour mapping, hillshade, aspect, slope, drainage networks, soil, depth to bedrock, and existing vegetation. Following this inventory, each student was tasked with the creation of a suitability analysis, aiming to quantitatively and qualitatively determine where 10 to 20 housing units and other program elements could be placed. The overarching goal of the analysis and planning effort was to propose conservation development that would conserve 40-60% of existing vegetation and natural systems within the site boundaries, leaving the smallest amount of impact possible.

Due to client budget constraints, site topography, and projected construction costs, the future of such a housing project at this location meant either exceptionally high upfront costs or the phasing of development to allow sufficient time for financial returns. A large amount of earthwork and vegetation removal may have needed to occur to meet Riley County Zoning, Riley County Subdivision Standards, and City of Manhattan Urban Area Subdivision Regulations. Because the associated risk of upfront cost to return on investment is high, alternative developmental plans should be created that increase the value of lands within and adjacent to the property before development begins. Greenway corridors have proven to have positive effects on increasing the value of taxable properties adjacent to the greenway (Little, 1990).

LAR 750 – Principles of Conservation Communities Specialization Seminar III, Fall 2011

“After decades of community development dependent on high inputs of resources, engineered solutions for storm water management, and reliance on the automobile as a dictator of spatial form, principles of Conservation Development are beginning to transform the status quo” (Hahn, 2011, p. 1). This seminar presented community development principles and trends from past to present through related readings and research. Students were then given the opportunity to discuss content and apply the knowledge gained from the research to their specific Conservation Development design in LAR 648 Specialization Studio.
Personal Goals and Objectives

1. To combine my interests for nature conservation, outdoor recreation, and landscape architecture; each providing for positive change in the places where we live and grow.

2. To increase my knowledge of landscape architecture, landscape ecology, and sustainable design practices and planning.

3. To explore how my personal interests and landscape architecture can combine together to foster the betterment of the landscape.

4. To explore standards for outdoor recreation, conservation, and the management of sensitive lands important for human beings, plants, animals, and the environment.

5. To further advance the knowledge of sustainable design practices and strengthen our understanding of the necessity for environmentally sensitive developmental strategies through landscape analysis methods.

6. To build support for conservation initiatives and allow for such research, analysis, and implementation to continue.
Design Philosophy

Our goal as designers and stewards of the land is to create awareness for nature through design that protects the natural processes and instills an appreciation for the environment regardless of the setting in which one might live. To do this we must seek to meet client’s needs while objectively assessing site characteristics and understanding relationships to the surrounding context. Design solutions that are multi-functional, appeal to multiple user groups, and provide better futures for the environmental, economic, and social systems at play are at the heart of holistic design.
Design Process - Research, Analysis, and Findings

The current dilemma and revised thesis statement formed my research questions for this project. As these research questions were established and revised, related literature was explored to gain useful insights on key issues and associated methodologies for greenway design. I explored several precedent studies that further explained the application of useful methods to develop my own unique methodology; one that could be altered to adhere to site specific characteristics while aiming to meet project goals and objectives.

After a clear methodological framework was established, the inventory and analysis phase of my project began. As new information was found, ideas for its inclusion were adapted to the framework, allowing for flexibility in the design process (Figure 1). Results of the analysis were then combined with specific conservation and design strategies to show the opportunities for such ideas to be explained, understood, accepted, potentially implemented, and explored in further research.

Figure 1. Process diagram
01 Project Introduction
Dilemma

As population increases nationally, natural resources are consumed and demands for the conservation of natural areas persist, projects that promote the smallest environmental footprint followed by the largest ecological and economic returns are at the forefront of 21st century design. The 2010 U.S. Census shows a 16.6% increase in Manhattan, Kansas population since 2000, growing from 44,831 to 52,281. This population figure accounts for the students of Kansas State University and local residents, as well as increases at Fort Riley (City of Manhattan, 2010). Kansas State University has set a new record for students enrolled, reaching 24,378 in the Fall 2012 semester (Kansas State University, 2013).

Also, population is expected to increase due to the construction of the National Bio and Agro-Defense Facility that will employ approximately 326 workers (Impact DataSource, 2012) and as soldiers return home from active duty overseas. Recent development such as the Flint Hills Discovery Center and the Manhattan Conference Center seek to be catalysts for cultural and economic revitalization of Manhattan’s south end. As this south end development continues combined with trends in population growth and visions to create a gateway experience into Manhattan, areas along K-177 are of particular interest to developers, planners, designers, conservationists, and city officials. Current and future land use within the K-177 corridor is varied; zoned as community commercial, rural residential, agricultural, and environmentally sensitive areas (Figure 2).

Topographic limitations and current inadequacies of water pressure within the Urban Service Area limit development to elevations below the 1120 ft contour level (Riley County Kansas, 2011). As a result of anticipated development, concerns regarding encroachment on natural areas, existing floral and faunal species, agricultural lands, drainage networks, wildlife habitats, and privately owned lands are being reassessed. Strategies for development must seek culturally and environmentally sensitive approaches to land planning. Continuing development patterns such as those seen along Manhattan’s westside and to the north (Figure 3 & 4) will likely promote destruction, fragmentation, and degradation of existing

Figure 2. Future land use map (http://www.rileycountyks.gov)
natural systems. Thus, it is necessary to develop new strategies that take both a conservationist’s and developer’s approach to assessing land development potential.

Differing values among numerous private landowners and other K-177 corridor stakeholders is also impeding development and conservation decisions. While creating public interest is an overall goal of the project, stakeholders receiving more immediate benefits from this research include: current landowners, conservation organizations working to protect Kansas’s remaining natural areas and open space, city and county planning boards, and developers seeking to provide guidance for the future development of property within the region. Each group of stakeholders and the individual values they represent remained crucial throughout the design process. Though these values may differ from one party to another, the results of this study look to initiate a discussion aiming to balance development needs and preserving landscape integrity.

Stakeholder Values

Because the site covers 378 parcels involving multiple stakeholders, it is difficult to determine what values each stakeholder, or groups of stakeholders, believe to be most important. As landowner surveys and community meetings exceeded the time frame of this research, the analysis was based on community input from the Gateway to Manhattan Plan and a practical understanding of current stakeholders and their values as I and my committee envisioned them to be (Figure 5). Though landowner values were not directly applied to the analysis, their values still remain the most important because final development decisions are informed through landowner consent. Therefore, by conducting analysis through conservationist and developer perspectives, the results of this study will provide landowners a chance to reassess their own values before deciding the best course of action for their land.

Figure 3. Manhattan’s westside development patterns (Google Maps)

Figure 4. Development patterns adjacent to Big Blue River (Google Maps)
Research Questions

1. How can conservation and development strategies be combined with greenway planning principles to protect lands adjacent to K-177?

2. How can locating areas most suitable for development from a conservationist’s and developer’s point of view help advance the goals and objectives of the GMP?

Thesis

In this master’s project I seek to utilize guidance of the GMP and conservation development strategies through analyzing an area of projected growth south of Manhattan Kansas along the K-177 corridor. In doing so, I will assess opportunities for multi-modal connectivity between located developable areas, while maintaining natural aesthetics through the conceptualization of a comprehensive greenway network.
Flint Hills Ecoregion

The K-177 corridor leading from I-70 to Manhattan is a scenic drive through the northern extents of the Flint Hills Ecoregion. This particular route and entrance into Manhattan is known for its natural character, scenic vistas, and presence of agriculture and grazing lands. Preserving the landscape integrity of such an important area should be a prominent goal as development decisions are made.

“The Flint Hills is a region of rolling hills with relatively narrow steep valleys, and is composed of shale and cherty limestone with rocky soils (Figure 6). In contrast to surrounding ecological regions that are mostly in cropland, most of the Flint Hills region is grazed by beef cattle. The Flint Hills mark the western edge of the tallgrass prairie, and contain the largest remaining intact tallgrass prairie in the Great Plains” (Chapman et al. 2001). Because the Flint Hills are crucial to the overall health of the Great Plains region and stands as a symbol for the state of Kansas, continued protection of this area is important if we wish to maintain healthy ecosystems and the cultural traditions for which we are so well known.


Figure 6. Generalized physiographic map of Kansas (http://www.kansasnativeplantsociety.org/ecoregions.php)
Study Area Location and Size (Figure 8 & 9)

Manhattan, Kansas

Study Area: **6,553 ac (acres)**

Total Parcels: **378**

The study area was delineated based on the focus area of the Gateway to Manhattan Plan (GMP) and extends to other significant destinations that include: Downtown Manhattan; the K-177 Scenic Overlook and Konza Prairie to the south, Fairmont Park and neighboring lands to the north Linear Trail; Flint Hills Discovery Center; Manhattan Kansas Union Pacific Depot, KS Hill; Kansas River Boat Ramp, and Kansas State owned land and Lazy T Ranch to the east.

**Site Context and Significant Destinations**

- Downtown Manhattan
- 177-Scenic Overlook
- Konza Prairie
- Fairmont Park
- Linear Trail
- Flint Hills Discovery Center
- Manhattan Kansas Union Pacific Depot
- KS Hill
- Kansas River Boat Ramp
- Lazy T Ranch

Figure 7. Regional map and location (Google Maps)

Figure 8. Study area and context
Study Area Photos and Character

Figures 9 - 24 express the character of the K-177 corridor and will allow a better understanding of research elements as they are presented. Current commercial areas are cluttered with billboards and used as storage space for equipment, distracting travelers along K-177 from the corridor’s naturalistic quality. Residential areas are characterized by large lot sizes that have further reduced the amount of natural areas. Vacant lots, current road access, and existing trails should be utilized first before future development decisions are made.

Figure 9. Commercial core billboards affecting natural character
Figure 10. Vacant parcel within commercial core adjacent to K-177
Figure 11. K-177 commercial core character
Figure 12. Residential development - Standel Road
Figure 13. Panoramic view of the K-177 corridor
Figure 14. Potential road access from Johnson Road

Figure 15. Crestline Drive

Figure 16. Vacant parcel along Crestline Drive

Figure 17. Rural road character - K Lane

Figure 18. Agricultural lands adjacent to Messenger

Figure 19. Existing trail near major powerline
Figure 20. Equestrian presence within K-177 corridor

Figure 21. Uncontrolled growth of eastern red cedar

Figure 22. Wooded trail within study area

Figure 23. Ridgetop trail within study area

Figure 24. Ridgetop panorama
Planning Context and Corridor Considerations

As a result of K-177’s naturalistic character and location within the internationally renowned Flint Hills, a strong desire to protect the scenic appeal of the corridor is a priority in the goals and objectives defined by the GMP. Previous residential development located along Manhattan’s western ridgelines has drastically altered the entrance experience and the natural character for which the region is so well known (Figure 25 - 27). Insensitive development atop and along ridges not only increases construction challenges, it also affects the natural character of the landscape and various environmental processes. Strategies that maintain the natural ridgetop’s aesthetic will not only contribute to the experiential quality as one enters the city, but will also help to protect vegetation, wildlife, and critical ecosystems that contribute to our larger water resources and provide clean air.

The majority of privately owned lands within the study area are zoned A-1 through A-5. Current zoning regulations for single family lots A-1 thru A-3 require a minimal lot size of ½ acre while zones A-4 and A-5 require a minimum of 2 acres (Riley County, 2013)(1). To protect the character and overall health of the K-177 corridor, conservation design strategies such as cluster development within these zones, outside the highway viewshed, and adjacent to current development are essential.

Zoning regulations for development within Manhattan and Riley County, combined with a demand to meet population growth, have led to development patterns that have had adverse effects on current natural systems. The Wildcat Creek Watershed is one example. Rapid development within the watershed has led to substantial erosion, impaired water quality, habitat loss, and property damage due to increased flood frequency (Wildcat Creek Watershed Council, 2013) (Figure 28 & 29). To ensure that similar impacts are avoided, it is important that further zoning regulations be set as to the amount and size of new development. These regulations may require that amendments be made to current zoning and developmental standards, which will be addressed in the Conclusions Chapter 5.

Since the K-177 corridor possesses a unique natural character and offers several opportunities for outdoor recreation, zoned lot sizes could be reduced to capitalize on the amount of open space aesthetic available and decrease the need for unnecessary infrastructure. Additional open space requirements as a result of new development could be met through linear open space design instead of the traditional nonlinear parks. This would increase the use of existing open space while minimizing the overall environmental impact by maintaining open space throughout the landscape.

A current lack of multi-modal connectivity across and along K-177, combined with a need to develop a trail network further supports the idea of promoting linear open space. This connectivity between new and existing development could be accomplished through the implementation of a comprehensive greenway network (2). Because greenways typically take a long time to be implemented, it is beneficial and necessary to execute a systematic approach to analysis and planning that can be easily understood by landowners and developers, allowing for accurate transitions between analysis, plan acceptance, and implementation.

2. See Background Chapter – Greenway Planning.
The goals for this study are reflective of the goals established in the GMP. By creating ecological, social, and economic goals based on the GMP, the results have met and could help advance developmental efforts within the K-177 corridor. Future strategies help explain how the goals could be implemented while also providing guidelines for future development decisions.

**Ecological Goals**

1. Show potential to conserve at least 60% of developable areas and lands within the study area
2. Identify contiguous habitat for native plant and animal species
3. Retain corridor’s scenic appeal and natural character
4. Conduct a preliminary assessment for future conservation initiatives

**Future Ecological Strategies**

1. Protect and enhance remaining riparian corridors that aid in sediment and nutrient filtration, erosion and sediment control, regulating water temperature, allowing groundwater recharge, and the overall health of the watersheds and rivers they serve
2. Avoid development adjacent to drainage networks by establishing buffers to reduce impact to the landscape’s natural systems and processes
3. Exclude development within the floodplain
4. Exclude development on ridges or ridgetops within the viewshed
5. Avoid development on steep slopes as to minimize accelerated erosion potential
6. Locate conservation areas and suggest conservation strategies

**Social Goals**

1. Show potential for a greenway network of active and passive recreation to connect development, historic destinations, culturally unique areas, scenic vistas, and other significant open space
2. Provide suitability maps and precedents to inform landowners on the structure, use, and benefits of conservation easements

**Future Social Strategies**

1. Develop a multi-modal trail network map to identify possible routes
2. Identify types of users of the greenway
3. Identify greenway strategies and resulting benefits
4. Provide alternatives for pedestrian and bicycle linkages across Highway K-177 and the Kansas River
5. Show potential for lands to remain under private ownership through the use of conservation easements
Economic Goals

1. Advance the efforts of the Gateway Plan through identifying developable areas
2. Identify opportunities for monetary tax incentives and increases in local revenue
3. Identify developable areas that require minimal earthwork to reduce upfront construction costs

Future Economic Strategies

1. Develop a plan that is in accordance with the economic goals and objectives of the GMP
2. Further discuss the importance of conservation easements for land protection and economic gain to inform landowners of their development options

This chapter identified key elements of my research and has explained characteristics of the study area that make it unique. Previous development within Manhattan was then discussed to express the need for new approaches to development that resist such negative environmental and aesthetic impacts. The next chapter presents several conservation and development strategies that have been used to protect lands from overdevelopment. Similar development strategies will be necessary to meet the goals of this study, the GMP, and to help conserve the landscape.
The following literature review and precedent studies cover the topics of greenway planning, conservation easements, methodological frameworks for land use analysis, and implementation strategies to consider when planning for land development. First, I explain two conservation strategies that have been instrumental in recent years in regards to land and habitat preservation, greenways and conservation easements. I then discuss the key components of the GMP and describe how I seek to provide solutions for development while adhering to the defined goals and objectives of the GMP. These resources define project elements and express their relevance in developing future plans for areas adjacent to K-177.

02 Background
Literature Map (Figure 30)

The literature map illustrates specific research topics, and corresponding literature. The map's purpose is to demonstrate the intellectual foundation from which this research project was created and express the literature's relevance to my design process and methodological framework.
Literature Review

Greenway Planning

Greenways help provide critical habitat for plant and animal species in addition to acting as buffers to filter stormwater of various nutrients, sediments, and contaminants before flowing into ponds, lakes, and streams. Greenways also offer unique passive and active recreation by linking historical, cultural, and scenic destinations, connecting to yet other greenways, and presenting several areas for quiet nature observation. (Arendt, 1994) (Figures 31 - 33). “By providing informal opportunities for people to experience nature close to home on a regular basis, greenways and other forms of open space may have an important and long-lasting effect on society’s environmental consciousness” (Smith, 1993, p. 17).

In order for a greenway to exist and foster the benefits discussed above, planning for the greenway must be comprehensive, methodical, and considered from the beginning stages of development. Since it far easier to reserve greenway corridors in advance of development rather than after the land is subdivided and sold, several municipalities have incorporated greenway networks into their official master plan policies and maps (Arendt, 1994). As businesses, subdivisions, and/or individual housing units are zoned and built, the greenway network can continue to act as a buffer to conserve sensitive natural habitats while growing along with development.

The natural character of the Flint Hills, ever changing topography, expansive panoramic views, and goal to keep private lands and sensitive habitats intact makes the implementation of a comprehensive greenway network within lands adjacent to K-177 desirable. These characteristics, combined with goals of establishing multi-modal connectivity along and across K-177, only further give support for such an amenity to exist. The greenway network would connect new and existing development, provide safe migratory routes for plant and animal species, safeguard private lands from overdevelopment, and allow greater opportunities to increase local revenues by acting as a catalyst for tourism.
Conservation Easements

In Gustanski and Squires’s (2000) book, *Protecting the Land: Conservation Easements Past, Present, and Future*, they present information pertaining to land trusts and conservation easements. They also explain the process of acquiring an easement and how it has evolved since easements were first established as a legal tool in the 1880s (Gustanski, Squires, & Hocker, 2000). Though a multitude of definitions exist for conservation easements, the Uniform Conservation Easement Act (UCEA) provides the following:

> “a nonpossessory interest of a holder in real property imposing limitations or affirmative obligations the purposes of which include retaining or protecting natural, scenic, or open space values of real property, assuring its availability for agricultural, forest, recreational, or open-space use, protecting natural resources, maintaining or enhancing air or water quality, or preserving the historical, architectural, archaeological, or cultural aspects of real property” (Gustanski, Squires, & Hocker, 2000, p. 508).

The challenge of creating such easements is in demonstrating how these areas will have greater environmental, economic, and social value if protected. Each easement must be specific to its location and regional context, assessing resources and assuring availability to meet state regulations regarding implementation and management of these unique areas.

Acquiring Easements

The first step to acquiring an easement includes the donation of specific lands to a land trust. Protective restrictions are then agreed upon between the agency and landowner that define future land uses. According to Kansas State Law (K.S.A. 58-3819 et seq.), a conservation easement may be held by a nonprofit conservation corporation, or by a federal, state, or local government (Kansas Land Trust, 2012). “The Kansas Land Trust, which was incorporated in 1990, meets all of the qualifications of Kansas Law as well as those imposed by Federal Law to qualify as a tax-exempt charitable institution under section 501(c)3 of the Internal Revenue Code” (Kansas Land Trust, 2012).

> “The conservation easement becomes a permanent part of the title, recorded with the county Register of Deeds” (Kansas Land Trust, 2012). For the easement to remain intact in perpetuity, the responsibility becomes that of the landowner to adhere to the established restrictions. These restrictions run with the title of the property forever, assuring long-term protection even if ownership were to change (Kansas Land Trust, 2012). Annual visits and assessments of the site are required by the Kansas Land trust to determine if restrictions are being met or if violations have occurred (Kansas Land Trust, 2012). If violations arise, landowners are notified of the necessary steps that must be taken to correct the damages or losses.

“The use of conservation easements has been slow to catch on in Kansas, having only been used by three entities, the Kansas Department of Wildlife and Parks (eighty-one easements), the Kansas Land Trust (four easements), and The Nature Conservancy (one easement)” (Gustanski, Squires, & Hocker, 2000, p. 431)(3). Since the publication of their book, Kansas conservation agencies and related organizations have continued to work with private landowners to successfully obtain easements totaling 288 to date (NCED, 2013). Two examples where such easements exist include the Flint Hills and Red Hills initiatives seen in Figures 34 and 35. As developmental pressures grow and new lands are assessed, conservation easements will likely play a crucial role in the protection of open space and natural areas throughout the state, especially lands adjacent to K-177.

3. This statistic was established from 1992 when Kansas passed conservation easement legislation to the publication of this book in 2000.

Figure 34. Flint Hills initiative (http://www.nature.org)

Figure 35. Red Hills initiative (http://www.nature.org)
Organizations that can assist with the protection of lands through conservation easements in Kansas include: Kansas Department of Wildlife and Parks, Kansas Land Trust, The Nature Conservancy, Ranchland Trust of Kansas, and Kansas State University(4). Though decisions to accept or decline easements are made at the state level, these particular organizations specialize in framing real estate decisions in conjunction with conservation strategies. These trusts also provide information regarding legal tools that have the potential to reduce capital gains tax, lower income taxes, and allow donors to receive income for life (Kansas Land Trust, 2012).

As pressures to develop continue, it will remain important that landowners understand the options that are available to them. By establishing such easements, landowners owning land adjacent to K-177 will have a greater ability to keep their land in private ownership, protect sensitive areas from overdevelopment, and create opportunities for tax incentives such as reduced estate tax. Though not required, land donated to a conservation easement can also provide significant recreation opportunities for resident and public users to further promote conservation initiatives, generate income for the landowner and community, and inform an environmental ethic.

Though not under easement restrictions, ranchers Ron and Chris Wilson, owners of the Lazy T Ranch in Manhattan, Kansas and within the eastern portions of the site boundary, have already been providing such an amenity for Manhattan residents and visitors. This family owned ranch offers educational sessions on farming and ranching life, while also providing entertainment such as cowboy poetry, good food, overnight stays, and scenic hayrack rides through the Flint Hills. Conservation easements combined with similar ecotourism operations could be another option available to landowners along K-177(5).

4. See Appendix - Contacts and Associated Organizations for more information pertaining to these organizations and how they work to protect land.

5. For more information on ecotourism and how it is being used to educate travelers, provide funds to conservation, and benefit local communities, refer to the Appendix - Ecotourism.
Gateway to Manhattan Plan

The GMP was adopted in 1998 through the efforts of the City of Manhattan, Riley County planning board, and extensive community participation (Riley County Kansas, 2011). The original plan was created as a result of anticipated development activity along K-177. Recent agreements to extend sanitary sewer and water services to the corridor has brought about a need to revise the original plans to reflect community desires, visions for the Gateway Corridor, and address changes as they relate to new infrastructure (Riley County Kansas, 2011). This 2011 updated plan establishes a number of goals, objectives, and action plans that must be considered as developable sites are evaluated.

Goal 1: Promote an attractive gateway corridor along K-177

Goal 2: Protect scenic views within the gateway corridor

Goal 3: Conserve natural and environmental resources in the gateway corridor

Goal 4: Respect the natural and rural character of the wildland - urban interface outside of the urban service area

Goal 5: Provide an appropriate level of services within the urban service area

Goal 6: Promote multi-modal connectivity along and across the K-177 corridor

Goal 7: Promote development in conformance with the future land use map and future vision for the corridor

(Riley County Kansas, 2011)

The primary focus area of the Gateway Plan is seen in Figure 36. Though the outer boundaries of the plan encompass a larger area, the most immediate concerns associated with development are the commercial core and urban residential areas along K-177 and within the Urban Service Area. The goals defined above reflect the efforts of planning boards, planning staff, and community members for the future of the gateway corridor. Similar project goals were used as a basis for my research with the results providing tangible solutions to promote conservation and development decisions. For a detailed list of the goals, objectives, and action plans from the GMP, or for more information on development types, please visit Riley County’s official website www.rileycountyks.gov.

Commercial and residential development should reflect the character established in the GMP and exist with minimal impact to natural systems (Figures 37 & 38). This development can be accomplished through new zoning ordinances that promote clustering development in order to maximize the preservation of remaining open space. According to the GMP, commercial areas will exist from McDowell Creek Road to approximately Lafayette Drive, while areas outside the commercial core and below the 1120 contour are designated as Urban Residential with densities ranging from one to eleven (1-11) dwelling units per net acre (Riley County Kansas, 2011).
The following precedent studies offer real world examples of greenway implementation, conservation design, and conservation easement strategies. Each precedent was selected for its usefulness in protecting lands from overdevelopment and for further aiding in the understanding of the concepts established in this master’s project. These strategies represent some of the many ways in which well-planned design promotes land conservation and should be used as a starting point for landowners and city officials when establishing conservation goals.
In 1995, the city of San Luis Obispo, California adopted a plan to create a greenbelt around the city to “retain a buffer between San Luis Obispo and its neighboring communities while preserving the community’s small-town character” (Gustanski, Squires, & Hocker, 2000; Stark, 1995) (Figure 39). Since the greenbelt area lies outside the city’s planning boundary, program success required the participation of individual landowners. The city also retained the Land Conservancy to assist in setting conservation priorities and developing the program. Methods used by the Land Conservancy to evaluate and acquire lands for the greenbelt are discussed in the following paragraphs. These methods were inspirational to this project and set the basic framework for analysis.

Land Ownership Inventory

The first step of analysis consisted of a land ownership inventory to identify which lands were in public or private ownership (Figure 40). Specific attention was given to areas already protected by land use restrictions and conservation easements as well as large areas under single ownership. Understanding where lands were under single ownership would allow for fewer conflicts between multiple landowners and easier land acquisition. Through mapping ownership, the Land Conservancy discovered that approximately fourteen people owned 55 percent of the proposed greenbelt area: a smaller number to negotiate with.

Interest and Community Values

After the ownership inventory was conducted, the Land Conservancy contacted targeted landowners using mailed surveys, community meetings, news articles, and workshops to generate interest in donating a conservation easement to the city or conveying title to their property. The hope was that these donations would provide for a continuous greenbelt. As a result, ten parcels were identified as currently available within the greenbelt area. These parcels became the starting point for analysis and evaluations.
Resource Mapping

Using a geographic information system (GIS), the conservancy identified important natural and cultural resources within the area. Noted resources included stream corridors, wildlife corridors, historically significant areas, scenic gateways into the city, and areas with rural character. These resources and individual maps were then combined into a single layer through the landscape unit method. The landscape units represent scale features that community members could easily identify as important resources.

Evaluation of Resources

Resources were evaluated through quantity, importance, and potential for valuable resource restoration. Quantity was based on the number of analyzed resources found within the landscape unit, referred to as the magnitude method of evaluation (Gustanski, Squires, & Hocker, 2000; Stark, 1995). The first map represented landscapes ranked with four scales of magnitude. To complement the magnitude method and account for resources that may have been overlooked, an importance evaluation was then conducted by rating areas on a scale of one (low importance) to five (high importance) (Gustanski and Squires, 2000; Stark, 1995). These resources were used to further determine which lands provided conservation and greenbelt opportunities within the greenbelt area.

Subjective variables used in the evaluation included the quality of resources, restoration potential, proximity to protected lands, unique views, scale of features, presence of historic features, input received at public meetings, and threat of development (Gustanski, Squires, & Hocker, 2000; Stark, 1995). “Landscape areas containing parcels with a potential for linking existing open space, areas containing rare, unique, or historic resources, and areas receiving high marks for importance from the public were given higher ratings” (Gustanski and Squires, 2000; Stark, 1995, page 408). Higher ratings were also given to areas with important resources threatened by development.

A final evaluation method used was titled resource potential. Resource potential was applied at the parcel level to exemplify restoration potential of the applicable lands found through the analysis stated above. This final evaluation was conducted in the event that a degraded parcel was offered a lower price where restoration would present a greater value towards the

Results of the Study

As a result of the study, the city began negotiations with four landowners in the area that led to two land acquisitions. The first was a fee acquisition of a 90-acre parcel along the side of a mountain. The mountain is a community landmark and can be viewed by the entire town. The site also had seventy developable sites with protected open space. A conservation easement was negotiated with the Land Conservancy to ensure that the lands would be conserved.

The second acquisition consisted of a conservation easement with over 1,500 acres of open space along the outer portions of the greenbelt. “This easement protects an entire subbasin of an important watershed and includes oak woodlands habitat, habitat for numerous wildlife species, and two rare plant species” (Gustanski, Squires, & Hocker, 2000; Stark, 1995, pg 409). The Land Conservancy has continued negotiations with other landowners to help protect unique areas within the proposed greenbelt region since the acquisition of these two easements. As a result, a total of 1,670 acres have been conserved since 1995 (Gustanski, Squires, & Hocker, 2000; Stark, 1995).

Relevance to My Research

The San Luis Obispo project is important for my research as it establishes a framework in which lands can be assessed for greenway selection. Similar to lands within the K-177 study area, the success of the project required the participation of individual landowners fostering community goals for conservation. The results demonstrate how such a process, while working closely with private landowners, can increase the potential for remaining lands to be conserved, protect the natural aesthetic, and create recreational opportunities for the community good.
The Woodlands stand as a model for early ecological planning and development from the 1970s. The initial idea for development began in the 1960s, when George Mitchell, a businessman and real estate developer, prepared a preliminary residential and light industrial master plan for the area (Forsyth, 2005). After being attracted by new federal programs providing loans for new development (Title VII), while also being encouraged to employ a larger staff, Mitchell hired Ian McHarg and his firm of Wallace McHarg Roberts and Todd (WMRT) to work along with planner, William Pereira, and several other professionals (Forsyth, 2005).

Due to the naturalistic character and gentle slopes of the Woodlands area, the WMRT team believed that the naturally occurring water systems were the most influential and fragile design element. Therefore, designs for development took into account soils, slope, drainage, water recharge, erosion, wildlife areas, and opportunities for recreation and open space (Forsyth, 2005). “It combines an emphasis on hydrology with an aesthetic that uses the original woods to mask development” (Forsyth, 2005, p. 60).

As The Woodlands has continued to develop, the design still includes a commitment to environmental protection. Compared to other Houston suburbs, The Woodlands has controlled run-off better, maintained more forested areas, and provided a path system of more than 100 miles (Forsyth, 2005). According to Forsyth (2005), deviations from the original plans exist: individual home owners clearing more forest to increase yard size while the use of a curb and gutter system has made newer development “more conventional.” The Woodlands now ranks in the top-10 for home sales in the country (Forsyth, 2005). If such increases in real estate development continue within The Woodlands and the initial ecological protection strategies are not followed, reductions in natural areas and negative impacts to water resources may result.
Relevance to My Research

The Woodlands is important to this research because it expresses how environmentally sensitive development strategies have been used to reduce the amount of impact to existing natural systems. Because the K-177 study area exhibits a much greater range of topographic variation compared to that of The Woodlands, it can be reasoned that important factors for the K-177 study area will be drainage networks, soil erosions, ground water recharge. These elements will remain critical throughout the design process. The Woodlands study also sheds light on the fact that decisions on the amount and size of development must be established at the beginning of the design process to restrict overdevelopment and protect those factors listed above.

Because it is difficult to determine the amount of development that can exist within a given area or how new development will affect the overall health of natural systems, a strategic phasing system may be required. This could occur through a development and monitoring process where the most suitable lands are first located and developed. The naturally occurring processes are then closely monitored to understand how development is affecting the area to decide if further development is possible. Phasing and monitoring of the natural systems would allow for a greater emphasis to be allocated towards conservation priorities as lands adjacent to K-177 are developed.
Grannybelle Woods Conservation Easement

Location: Maryville, Tennessee  
Date: 1987  
Author: Randolph Y. Brown  
Client: Kerwin and Vera Stalling

Kerwin and Vera Stallings moved from New York City in 1987 to Blount County Tennessee, acquiring 200 acres of overgrown farmland in the foothills near Maryville, Tennessee. Their intentions were to create an “economically viable hobby farm in an environmentally sensitive manner” (Gustanski, Squires, & Hocker, 2000; Brown, 1987). To do this, the site was programmed with low-intensity arable farming areas and a country estate suitable for walking and horseback riding. To protect erosion-prone areas of the site, 80 acres of land was sold and divided into eleven tracts, each between 5 and 10 acres (Figure 44).

Development for Grannybelle Woods took an approach similar to The Woodlands for the protection of sensitive areas. Restrictions were set on the amount of clearing to take place for lots, lawns, and gardens as well as what could be visible along the narrow lanes of the development. Working with the Foothills Land Conservancy, an easement was created and signed for the Stalling’s land in 1993 (Gustanski, Squires, & Hocker, 2000; Brown, 1987). In addition to preserving tracts of land, the easement assured residents that adjoining properties would remain undeveloped. Grannybelle has not only been successful for the Stallings’, residents, tourists, nearby neighbors, and wildlife but has also had a positive effect on the Great Smokey National Park by providing a block to suburban sprawl at this location (Gustanski, Squires, & Hocker, 2000; Brown, 1987). This project has also been a catalyst for other Foothills Land Conservancy projects, protecting more than 8,000 acres of land within five years of Grannybelle Woods’s establishment (Gustanski, Squires, & Hocker, 2000; Brown, 1987).

Relevance to My Research

Conservation and development strategies such as those present in the Grannybelle Woods study could be implemented to protect the Flint Hills and the scenic character of lands along K-177. Shortages in clean water and rising temperatures are already affecting Kansas farmers and residents (Kansas Department of Agriculture, 2011). Overdevelopment within the K-177 corridor would not only have significant impacts on current natural systems, but could also further affect Kansans through increasing the demand for clean water.
To create development strategies such as those presented in this chapter, conservation and developer values must be considered and balanced before decisions to locate development begin. Table 1 and Table 2 express these values and give brief explanations of why they were chosen. The methods and conclusions chapters that follow explain how these values were established and how they were used to create alternative development plans. These alternative plans express how different strategies might affect lands adjacent to the K-177 corridor. I then provide explanations on the implications of such strategies and discuss how further conservation planning must be established if development is to occur with minimal environmental impact.

### Developer Values

<table>
<thead>
<tr>
<th>Slope</th>
<th>Cost of construction, amount of earthwork, and number of houses possible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drainage Networks</td>
<td>Avoid development in these areas to limit damage to new property</td>
</tr>
<tr>
<td>Existing Utilities</td>
<td>Locate in close proximity to existing utilities to limit cost</td>
</tr>
<tr>
<td></td>
<td>Avoid damage to existing utilities caused by ill-planned construction operations</td>
</tr>
</tbody>
</table>

Table 1. Developer Values
### Table 2. Conservationist Values

#### Slope
- Reasonable cost of construction, minimal amount of earthwork, and reasonable number of houses
- Control water speed and velocity
- Reduce issues related to erosion and stormwater run-off
- Provide a range of user experiences

#### Drainage Networks
- Exclude development to maintain or enhance water resources
- Protect overall health of watersheds and ecosystems
- Protect existing habitats and vegetation communities

#### Existing Utilities
- Locate in close proximity to existing utilities to limit cost
- Avoid damage to existing utilities caused by ill-planned construction operations
- Limit additional damage to the environment brought about through construction operations

#### Soils
- Reduce compaction
- Maximize ground water recharge
- Avoid soils where critical vegetation communities exist
- Limit development in areas where bedrock layers are deeply embedded

#### Land Cover
- Promote clean water and air
- Provide critical habitat
- Provide shade and blocks views

#### Aspect
- Promote and protect solar gain opportunities
- Crucial in determining the location of vegetation communities
- Aid in soil stabilization by drying soil
The goal of this background chapter was to explain how effective conservation and development strategies have assisted in the continued preservation of our remaining natural areas and help to support the research questions established for this project. The first precedent study, Saving Special Places, explores the necessary steps of assessing and acquiring lands for a connected “greenbelt” or “greenway” network. Greenway networks are becoming an even more integral part of current conservation initiatives, sustainable development projects, and “green” thinking as we advance into the 21st century. They remain the threshold between the built and natural environments, seeking to connect people to nature, protect wildlife corridors, safeguard lands from development, and support inward growth. Without systems such as these in place, the naturally occurring processes are often harmed irreparably.

The Woodlands and Grannybelle Woods studies are some of many examples of how conservation and development strategies have been combined to limit growth and help protect sensitive environments. It also allows one to gain a greater understanding of the further implications of such development strategies. The Woodlands has become one of the greatest examples of ecological planning and design to date and continues to be a precedent for other developing communities even in its current compromised condition. The Grannybelle Woods Conservation Easement not only protected land within the Stallings’s property but also helped block suburban sprawl from advancing towards the Great Smokey National Park; it also provided opportunities for active outdoor recreation and initiated similar projects to protect a total of 8,000 acres within five years of its establishment (Gustanski, Squires, & Hocker, 2000).

My research seeks to provide a framework for future land conservation initiatives along K-177 and extending into the local Flint Hills. The outcomes seek to generate interest in landowners, land trusts, and governing bodies; it is my hope that a greater amount of conservation interests and well-planned development will result. Detailed analysis and planning of areas where potential greenways, development, and easements could be implemented will allow for better communication between landowners, land trusts, and
Methods for this project include a similar approach to that described in the precedent study, *Saving Special Places* (Gustanski, Squires, & Hocker, 2000; Stark, 1995) (Figure 45). Utilizing online geodata bases and previously collected data for Riley County from college archives, a site inventory was conducted using ArcGIS 10.1 to better understand current demographic, social, and ecological conditions. After the information was inventoried and synthesized using tools within GIS, the suitability analysis phase began.

Analysis of the data collected in the inventory phase begins establishing relationships among the factors. Through analysis, we can help explain how particular factors function within the landscape. Understanding these relationships allows us to make educated decisions as to what areas offer opportunities or constraints based upon specific criteria. Analysis for this project uses geographic overlays to produce various suitability maps in which factors are rated, reclassified, and overlaid to express the most suitable locations for development and greenway selection.
Methodology Diagram

Study Area Inventory

Data Collection

Ecological Factors
- soils
- aspect
- wetlands
- floodplain
- topography
- depth to bedrock
- existing vegetation
- drainage networks
- endangered species
- wildlife habitats/corridors

Land Use
- zoning
- parcel data
- land ownership
- industrial
- residential
- mixed-use
- institutions
- commercial
- recreation areas
- conservation areas

Infrastructure
- utilities
- rights-of-way
- existing trails
- major/minor roadways

Viewshed Study

Analysis

Suitability

GIS Model

Conservationist Values

Developer Values

Trail Suitability

Figure 45. Methodology diagram
### Results & Conclusions

<table>
<thead>
<tr>
<th>Alternative Plans</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative 1</td>
<td>Easements</td>
</tr>
<tr>
<td></td>
<td>Native Vegetation Restoration</td>
</tr>
<tr>
<td></td>
<td>Vegetation Management</td>
</tr>
<tr>
<td></td>
<td>Stream and Drainage Setback Ordinances</td>
</tr>
<tr>
<td></td>
<td>Parkland Dedication</td>
</tr>
<tr>
<td></td>
<td>Transfer of Developmental Rights</td>
</tr>
<tr>
<td>Alternative 2</td>
<td>Limited Developmental Plans</td>
</tr>
<tr>
<td></td>
<td>Cluster Ordinances</td>
</tr>
<tr>
<td>Greenway Selection</td>
<td>Agriculture Land Protection</td>
</tr>
<tr>
<td></td>
<td>Grazing Land Protection</td>
</tr>
<tr>
<td></td>
<td>Protection of Erosion Prone Areas</td>
</tr>
<tr>
<td></td>
<td>Invasive Species Control</td>
</tr>
<tr>
<td></td>
<td>Rare Species Protection</td>
</tr>
</tbody>
</table>
Study Area Inventory

The factors used and their relevance to the study are explained in Table 2. Information pertaining to existing conditions and how certain factors were selected within GIS is explained. The following section will provide an overview of the study area and allows for a greater understanding of specific site elements and conditions. A general understanding of the factors used, their classifications, and how some were created within GIS will allow an understanding of the overall methods used and the results to follow.

### Land Ownership

Understanding land ownership was important to further determine which parcels would allow for fewer conflicts and dealings with multiple owners. Specific parcels with few owners can then be selected as recommended targets for greenway and/or development.

### Land Zoning

Zoning regulations will remain important as sites for development are chosen. In order to accommodate particular types of development, it may be necessary to amend specific zoning regulations to better distribute development to suitable lands.

### Land Use

Understanding the current land use and vegetation within the site further defines how the site is currently functioning and allows for better decision making as to where greenways and new development should be located.

### Infrastructure

Current infrastructure and building locations express the distribution of development and access throughout the site. Utilizing existing roadways and utilities as much as possible will reduce the cost for additional infrastructure.

### Existing Trails

These trails are a prime starting point for a trail network because soil compaction has already taken place and their utilization can limit such occurrence in other locations.

### Slope

New locations for residences, businesses, and their connecting greenways must adhere to gentle and moderate slopes as much as possible while utilizing existing roadways. Minimizing development along steep slopes reduces erosion potential, run-off, and impacts to existing natural systems.

### Aspect

Site locations and buildings designed with proper aspect can capitalize on solar gain to reduce energy cost through natural lighting or by using photovoltaic cells (solar panels). Aspect also remains important for greenway development by routing trails where sufficient sunlight is present to keep soil moisture and erosion to a minimum.

### Soils

Soils were evaluated for their compaction rates, infiltration rates, erosion potential, and ability to foster existing or new vegetation. Locating these soils and understanding their properties allowed for residential, commercial, and greenway development to exist in the most suitable locations with minimal impact.

### Watersheds and Drainage Networks

Watersheds are important because they feed larger bodies of water and drain land of excess water. Drainage networks play an important part in the overall health of the watershed and existing ecosystems. Development should be avoided or limited within these areas. Siting greenways adjacent to or within major drainage networks can help to protect the well-being of existing natural systems by providing buffers to development.

Table 3. Site inventory factors and relevance to study
FEMA Floodplain

Avoiding or limiting development in these fragile areas of the watershed will increase the likelihood that the watershed itself and other bodies of water will remain healthy.

Wildlife Habitats, Rare Species, and Protected Areas

Wildlife habitats, rare species, and protected areas are crucial for assessing greenway and development potential because overdevelopment increases the chances of habitat destruction, fragmentation, and degradation.

Viewshed

The viewshed study is important because protection of the viewshed and naturalistic quality of the corridor is a major goal of the GMP. By overlaying the viewshed study map with my development suitability analysis, more specific development locations could be expressed.
Land ownership and Zoning

Using existing parcel data, land ownership was categorized into six ownership types: State of Kansas, Riley County, City of Manhattan, Kansas State University, The Nature Conservancy, and Private. Private lands were further subdivided into seven subcategories based on whether the parcel was a single owner, multiple owners (ETAL), under trust, under trust with multiple owners, owned by a business, owned by a church, or partially owned (1/2 INT) (Figure 46). Current zoning within the parcels consists mainly of General Agriculture Lands (G-1). The remaining parcels are zoned as Single Family (A-1 – A-5), Two Family (B-1), Mobile Home Park (B-3), General Business (C-3), Highway Business (C-4), Light Industry (D-2), Heavy Industry (D-3), Planned Unit Development (PUD), and University Land (U) (Figure 47). This inventory identified ownership of land and whether or not parcels were owned by one or few landowners, providing a guide for the number of landowners needed to negotiate development decisions.

Land Cover

The National Land Cover Dataset (NLCD) (USDA, 2012) was used to express current land use within the study area (Figure 48). The majority of residential and commercial development exists within close proximity to K-177, while the remaining low intensity development is adjacent to the major arterial roads. Current vegetation consists mainly of deciduous, evergreen, and mixed forest along steep slopes and major drainage networks while a mixture of herbaceous plants cover the ridgetops.

Because irregularities in deciduous and evergreen forests were noticed between the NLCD data and aerial photography, an additional evergreen location map was created by tracing evergreen locations from the aerial photography. Since concerns for the management of red cedars within the region have been noted, these locations offer great opportunities to position new development. Evergreen locations also become key areas for greenways implementation with an accompanying management plan to help reintroduce or enhance native vegetation. Native vegetation provides a greater ability to filter stormwater, improves soil quality, and adds to the overall health of the watershed and the natural aesthetic values.
Figure 46. Land ownership by type
Figure 47. Land zoning by type
Figure 48. Land cover

Legend
- Study Area
- 1120 Contour
- 11 - Open Water
- 21 - Developed, Open Space
- 22 - Developed, Low Intensity
- 23 - Developed, Medium Intensity
- 24 - Developed, High Intensity
- 31 - Barren Land
- 41 - Deciduous Forest
- 42 - Evergreen Forest
- 43 - Mixed Forest
- 52 - Shrub/Scrub
- 71 - Herbaceous
- 81 - Hay/Pasture
- 82 - Cultivated Crops
- 90 - Woody Wetlands
- 95 - Emergent Herbaceous Wetlands

Figure 48. Land cover
Infrastructure

The study area includes two major roadways that move traffic generally north and south along K-177 and McDowell Creek Road. Several paved and gravel arterial roads branch to the east and west to connect existing rural development. Current utilities are present below the 1120 foot elevation and exist within the Urban Service Area, while major power lines traverse the study area both north to south and east to west. The only current paved pedestrian path is an existing 3000 foot segment of sidewalk that extends from the northwest corner of Zeandale Road and K-177 across the Kansas River bridge and terminates at the Union Pacific Depot (Figure 49).

Significant destinations within the study area include Fairmont Park, the Kansas River boat ramp, and KS Hill to the north; the 177- Scenic Overlook and Konza Prairie to the south; and the Lazy T Ranch to the east. To connect these significant destinations existing trails were mapped using aerial photography. These trails appear to have been created mostly by current private landowner activity, grazing patterns of range animals and other wildlife, or by vehicles used in areas owned by Kansas State University.

Slope and Aspect

Using the Spatial Analyst Arc GIS tool and ten meter digital elevation model (DEM) data, slopes and aspect were calculated to understand where the most suitable locations for development could exist (Figures 50 & 51). Slopes within the study area range from 0 to 57 percent. Steeper slopes are located along the ridgelines and major drainage networks. Moderate to gentle slopes are found on the ridge tops and at lower elevations, such as floodplains, where development already exists, and to the north near Fairmont Park. Aspect depicts slope orientation relative to the sun. This is important for locating vegetation communities and will remain important while locating areas for development or greenway trails.
Figure 49. Current infrastructure and mapped trails
Figure 50. Slope
Figure 51. Aspect
Soils

Soils were inventoried and studied according to data attributes and Riley County Soil Survey documentation (Figure 52). The purpose was to locate soils representing high erosion potential or high compaction and infiltration rates. These areas should be limited to development or left undeveloped due to accelerated erosion, or because of their importance in the overall health of ecosystems. The soils along the steeper slopes consist mainly of a Clime-Sogn complex (Clime 5 to 20 percent, Sogn 5 to 8 percent). Clime soils are “moderately deep and are moderately well drained” with a low permeability rate; the sub-layers of the Clime series consist of silty to heavy silty layers, making the soil “hard when dry and firm when moist” (NRCS, 1975, p. 13).

Sogn soils occur at gentler slopes above a hard layer of limestone and are somewhat excessively drained. In Riley County, both soils are represented within the Clime-Sogn complex (NRCS, 1975). Since erosion in these areas is already of great concern, residential and commercial development should be limited. Although this soil complex is not particularly suitable for building construction, a low compaction rate accompanied by heavy existing vegetation in certain locations makes this complex a candidate for trails and greenway implementation.

The major soils along current drainage networks within the study area consist of the Wymore-Kennebec complex. The Wymore series is located on level to sloping soils in upland regions of the complex. It is well to moderately well drained with slow permeability. Kennebec soils occur on nearly level slopes, in bottomland areas, and along most creeks within the study area (NRCS, 1975). Kennebec is also classified as well to moderately well drained but has moderate permeability (NRCS, 1975). Due to concerns with compaction, ability to infiltrate water, and the presence of heavy vegetation within the Kennebec soils, development in these areas should be avoided. It is important to note that though there is a potential for development within the Wymore regions of this complex, it should be limited or designed as to not cause significant changes to the existing natural systems.
Figure 52. Soils

Legend

- **Study Area**
- **1120 Contour**

**Soils**

<table>
<thead>
<tr>
<th>MUNAME</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benfield-Florence complex, 5 to 30 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Chase silt loam, very rarely flooded</td>
<td></td>
</tr>
<tr>
<td>Clime silt loam, 20 to 40 percent slopes, very stony</td>
<td></td>
</tr>
<tr>
<td>Clime-Sogn complex, 3 to 20 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Dwight-Irwin complex, 1 to 3 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Eudora-Urbanland complex, rarely flooded</td>
<td></td>
</tr>
<tr>
<td>Geary silt loam, 3 to 7 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Grant silt loam, 3 to 7 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Ivan and Kennebec silt loams, occasionally flooded</td>
<td></td>
</tr>
<tr>
<td>Ivan silt loam, channeled</td>
<td></td>
</tr>
<tr>
<td>Ivan silt loam, 1 to 3 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Ivan silt loam, channeled</td>
<td></td>
</tr>
<tr>
<td>Ivan silt loam, channeled</td>
<td></td>
</tr>
<tr>
<td>Ivan silt loam, rarely flooded</td>
<td></td>
</tr>
<tr>
<td>Muscota silt loam, 1 to 3 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Reading silt loam, moderately wet, very rarely flooded</td>
<td></td>
</tr>
<tr>
<td>Reading silt loam, rarely flooded</td>
<td></td>
</tr>
<tr>
<td>Stonehouse-Belvue complex, occasionally flooded</td>
<td></td>
</tr>
<tr>
<td>Tully silt loam, 1 to 3 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Tully silt loam, 3 to 7 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Tully silt loam, 3 to 7 percent slopes, eroded</td>
<td></td>
</tr>
<tr>
<td>Water</td>
<td></td>
</tr>
<tr>
<td>Wymore-Kennebec complex, 0 to 17 percent slopes</td>
<td></td>
</tr>
<tr>
<td>Zeandale silt loam, occasionally flooded</td>
<td></td>
</tr>
</tbody>
</table>
Drainage

Two watersheds categorized as Hydrologic Unit Codes (HUC) 12 watersheds exist within the study area: the Blackjack Spring and the Eureka Lake. Tributaries with minimal adjacent vegetation often have a reduced ability to filter water efficiently and can lack the structure needed to hold the soil in place, leading to increased erosion and deposition of sediment downstream. Maintaining high amounts of native vegetation within the study area will likely provide greater support to the overall health of current watersheds and the larger bodies of water they feed.

As seen from the FEMA floodplain data, the only areas located within the floodplain exist to the north of the study area. Therefore, avoiding or limiting development in these areas of the watershed and floodplain will increase the likelihood that the watershed itself and other bodies of water will remain healthy. If development were to occur within the floodplain, measures should be taken to prepare the sites for possible future flood events through the implementation of various stormwater best management practices (BMPs), such as reintroducing wetland vegetation within the floodplain.

Drainage networks were then inventoried using the DEM data and Arc Hydro tools within GIS. Arc Hydro offers a starting point for understanding water resources. The tools allow a user to delineate flow direction (FDR), flow accumulation (FA), and drainage networks through terrain processing of the DEM data (Figure 54). The DEM data is converted to a grid within GIS with the software having the capabilities to calculate the number of cells existing within a given area. In this research, the 2nd order streams within the study area are expressed as 5000 cell FA while the 1st order streams are defined as 500 cell FA. As discussed in the watershed description, the drainage networks play an important part in the overall health of existing ecosystems and as such should be avoided during development.

![Flow direction and accumulation tools](http://resources.arcgis.com/)
Figure 54. Watersheds, drainage, and FEMA floodplain
Rare Species and Protected Areas

Since a major goal of this project (Ecological #2), the GMP (Goal #3), and conservation planning is to protect potential existing habitats, rare species and protected areas were inventoried and mapped (Figure 55). Previous Riley County-GIS (2006) data was used to understand where rare species are presently located and what areas are already under protection. Rare or threatened species mapped within the study area consist of bird species such as the Least Tern (*Sterna antillarum*) and Prairie Chicken (*Tymanuchus cupido*), a vascular plant, Pale Goosefoot (*Chenopodium pallescens*), and the mammal Southern Bob Lemming (*Synaptomys cooperii*) (Riley County, 2006).

Several other important floral and faunal species are also known to be located in the Flint Hills region. Important prairie vegetation includes: Buffalograss (*Bouteloua dactyloides*), Indian grass (*Sorghastrum nutans*), Big bluestem (*Andropogon gerardii*), Little bluestem (*Andropogon scoparium*), Blue grama (*Bouteloua gracilis*), and Switchgrass (*Panicum virgatum*). Important wildlife includes: Bison (*Bison bison*), Mule deer (*Odocoileus hemionus*), White-tailed deer (*Odocoileus virginianus*), along with several species of grasshoppers, butterflies, mammals, amphibians, and reptiles (Wright & Baker, 2005). Protecting the habitats for these species is important for the overall health of current ecosystems. Overdevelopment within these habitats increases negative impacts to environmental health through habitat destruction, fragmentation, and degradation.
Figure 55. Rare species and protected areas
**Viewshed**

Two goals of the GMP are to protect scenic views and maintain the natural character of the corridor; therefore, a viewshed study was conducted to identify areas that are either visible or hidden from travelers along K-177. This viewshed analysis was conducted using the Viewshed Analysis tool and DEM data within GIS. This tool allows viewpoints to be created and compares these viewpoint elevations to that of the DEM. Using the NLCD, heights of 80, 60, and 40 feet were given to the deciduous, evergreen, and mixed forest layers and merged with the DEM data to represent elevation of existing vegetation in addition to topographic elevations.

Portions of the study area can be seen by travelers along K-177, from nearby hillside residents, and some areas of Manhattan (Figure 56). Time did not permit in-depth visual mapping and analysis of various viewer groups and visual sensitivities. However, since the K-177 corridor has been identified as the southern gateway to Manhattan, a priority viewshed analysis was conducted for K-177 travelers.

Viewpoints were created at 100-yard intervals, beginning from the furthest southern boundary of the study area and stopping just short of the Kansas River Bridge to the north. A five foot height was also factored into the viewpoints to account for travelers being elevated from ground level. Results revealed moderate to high visibility within areas adjacent to K-177, leaving a limited number of parcels where development could exist outside the viewshed.
Figure 56. Viewshed
Analysis of Inventoried Criteria

The first step of the research analysis takes stakeholder values and related study area inventory factors and creates two suitability maps that express development potential. One map is from a developer’s standpoint and the other from that of a conservationist. Reflecting the stakeholder value diagram Figure 57 and Table 1 (discussed in Chapter 2), study area inventory factors closely related to a developer’s set of values are reasoned to be slope, drainage network, and existing utilities. Taking the developer’s approach a step further, a conservationist’s set of values would also include aspect, soil type, and land cover to locate more specific sites for development as to maximize conservation potential.

GIS ModelBuilder was used to generate the “conservationist” and “developer” suitability studies. The factors were added, reclassified, and given a specified percentage of influence using the weighted overlay method in modelbuilder. By developing these models for assessing conservation and development potential, factors can be quickly reclassified or given different percentages of influence based on community input and planning needs. This allows for real time alternative plans to be developed in which planning boards and community members can base their future decisions.

Suitability ratings for the inventoried data and the resultant suitability maps were based on a 0 to 3 rating system and were classified as follows: 0-no development, 1-low development, 2-moderate development, and 3-high development suitability. The specific criteria used for each suitability map and how factors were reclassified is explained in the conservationist and developer values sections.

6. For a more detailed description of how factors were reclassified using GIS model-builder and tools, refer to the Appendix – Technical GIS Analysis.
**Developer Approach**

To express development potential from a developer’s perspective, three factors were utilized and overlayed during this analysis: slope, drainage networks, and existing utilities (Figure 58). These factors were placed within GIS ModelBuilder, reclassified based on suitability for development, converted into a raster dataset, given specific color values to represent suitability, and then combined using the weighted overlay tool. The slope map was reclassified based on categories from the City of Manhattan Land Development Codes. These categories and their associated suitability ratings are as follows: 0%-5% = 3-high development, 5.01%-8% = 2-moderate development, 8.01%-20% = 1-low development, 20.01%+ = 0-no development.

Buffers of 66 feet (Kansas Bureau of Water Protection, 2010) were created around the 2nd order (5000 FA) and 1st order (500 FA) streams to protect them from development. The 5000 FA was given a suitability rating of 0 while the 500 FA was given a suitability rating of 1 (low development) to ensure the protection of water resources. All remaining lands not within these drainage networks were given a suitability rating of 3 to represent areas most suitable for development.

A buffer of 16 feet was then created around existing utilities of sewer and water. By doing this, current utilities are more likely to be protected as a result of construction operations. Areas within the 16 foot buffer were given a suitability rating of 0 while the remaining areas were given a suitability rating of 3.

After these factors were reclassified into their associated suitability ratings and colors, a weighted overlay was added to the model and run to express the resultant development suitability (Figure 59). For the purposes of this particular developer analysis, all three factors were given an equal influence of 33-percent, although, since the weighted overlay does not compute irrational numbers, the drainage networks were given an influence of 34 percent.

Though Figure 59 expresses development suitability for the entire study area, for the purposes of this study, the results were clipped to areas below the 1120 contour (Figure 60). Clipping developable areas to below the 1120 contour reflects the anticipated Commercial Core, Urban Residential, and Urban Service Areas as seen in the GMP. Also, areas of low and no development were excluded from the map because they occurred primarily in the drainage networks or where development already existed, thus removing them allowed for the map to be more easily understood.

Areas over 1120 still remain important due to the fact that the GMP has stated these areas may be developed as Rural Residential development, meaning “densities range from two to twenty (2-20) acre sites, although some tracts may exceed twenty acres” (Riley County Kansas, 2011. p. 15). The trouble with siting residential units in these locations is that there is only limited road access above the ridgeline, therefore, a decision would have to be made to determine if it is worth the road construction cost and negative impacts to the natural systems for such minimal development. A few potential roadways will be discussed in Chapter 6 Further Research.

In accordance with the GMP, urban densities within these areas shall range from one to eleven (1-11) dwelling units per net acre, equating to Residential Low/Medium Density as defined in the Manhattan Urban Area Comprehensive Plan (Riley County Kansas, 2011). According to the GMP, these housing types include: single-family homes, duplexes, townhomes, and smaller apartment buildings; therefore, by clustering development larger habitat patches can be protected while creating the potential to accommodate an equal number of residents.
Figure 59. Developer’s suitability
Figure 60. Developer’s suitability clipped to 1120 contour
Conservationist Approach

Development potential expressing a conservationist’s perspective assessed six factors: slope, drainage networks, existing utilities, land cover, aspect, and soils (Figure 61). A similar process of GIS modeling as described in the development suitability was used. This was followed by a weighted overlay of the six factors. I also used the same suitability classifications for slopes, drainage networks, and existing utilities as mentioned for the developer’s analysis. High and moderately suitable areas (orange and yellow) represent the areas with most development potential while areas of low and no development (light green and dark green) represent the lands most desired for conservation.

Using the NLCD data, land use was reclassified based on an understanding of the goals and objectives of the GMP: maintaining K-177’s naturalistic and scenic quality, conserving natural resources, protecting wildlife areas, controlling invasive species, and preserving the remaining croplands. Table 4 below illustrates the NLCD categories and their associated suitability ratings.

<table>
<thead>
<tr>
<th>Land Cover</th>
<th>Suitability Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Water</td>
<td>0</td>
</tr>
<tr>
<td>Developed, Open Space</td>
<td>0</td>
</tr>
<tr>
<td>Developed, Low Intensity</td>
<td>2</td>
</tr>
<tr>
<td>Developed, Medium Intensity</td>
<td>0</td>
</tr>
<tr>
<td>Developed, High Intensity</td>
<td>0</td>
</tr>
<tr>
<td>Barren Land</td>
<td>3</td>
</tr>
<tr>
<td>Deciduous Forest</td>
<td>3</td>
</tr>
<tr>
<td>Evergreen Forest</td>
<td>3</td>
</tr>
<tr>
<td>Mixed Forest</td>
<td>3</td>
</tr>
<tr>
<td>Shrubs/Scrub</td>
<td>2</td>
</tr>
<tr>
<td>Herbaceous</td>
<td>0</td>
</tr>
<tr>
<td>Hay/Pasture</td>
<td>1</td>
</tr>
<tr>
<td>Cultivated Crops</td>
<td>1</td>
</tr>
<tr>
<td>Woody Wetlands</td>
<td>0</td>
</tr>
<tr>
<td>Emergent Herbaceous Wetlands</td>
<td>0</td>
</tr>
</tbody>
</table>

Aspect was reclassified to reflect the areas receiving the most amount of sunlight to the least amount. For this research, areas representing a high suitability in terms of aspect are located Southeast (112.5-15.5), South (157.5-202.5), and Southwest (202.5-247.5), moderate suitability – East (67.5-112.5) and West (247.5-292.5), and low suitability – North (0-22.5), Northwest (292.5-337.5), and Northeast (22.5-67.5). Soil suitability ratings were based on the soils location along the slope and the Riley County soil data categories of well suited and poorly suited site preparation. All soils within 0-6% were given a suitability rating of 3 while a suitability rating of 2 was given to soils with 6 percent slopes but representing a poor site prep classification. Slopes ranging from 10-15-percent were given a suitability rating of 1 while slopes greater than 15-percent were given a rating of 0.

Factors were then combined in the weighted overlay and given specific percentages of influence that are as follows: slope (20%), drainage networks (30%), existing utilities (10%), land cover (20%), aspect (10%), and soils (10%). The resultant map expresses development potential reflective of a conservationist set of values (Figure 62). Again, the results were clipped to exclude suitable areas above the 1120 contour to reflect the GMP Commercial Core, Urban Residential, and expected Urban Service Areas (Figure 63). Development within areas of moderate suitability (2- moderate development) should be limited while areas of high suitability (3-high development), represent the most suitable sites for development.

Table 4. Development land cover suitability

7. The resultant map reflects approximate location of land cover due to the cell size of the 30 meter NLCD data. Further mapping of specific vegetation locations through site visits could enhance this study.
Figure 62. Conservationist’s suitability
Figure 63. Conservationist’s suitability clipped to 1120 contour
Selection of Focus Parcels

Fifty parcels were selected because they either exist below the 1120 contour, are in close proximity to existing development, have minimal or no existing buildings, or are owned by one or few landowners (Figure 64). A total of 34 parcels existing under or having area below the 1120 contour were selected. These parcels express the most immediate lands for development. A total of 16 parcels were selected above the 1120 contour adjacent Crestline Drive. These 16 parcels are important because they express the most immediate lands for development above the 1120 contour. The results that follow are based on the 37 focus parcels existing within or below the 1120 contour.

Figure 64. Parcel selection
Comparing Alternative Plans

The final step of the development analysis involved overlaying and comparing the developer and conservationist suitability maps. Each approach is important in understanding how different development strategies can impact the environment and current landowners. The total developable area represented in both approaches and the implications for what these approaches mean for the future of lands adjacent to K-177 are discussed in the results and conclusions chapters.

Viewshed Overlay

The next step of the development analysis involved overlay of the viewshed study with the resultant suitability maps. This process expressed developable areas within and outside of the K-177 viewshed from both the conservationist’s and developer’s approach. For the purposes of this phase of analysis and to reflect the GMP’s goals of protecting scenic views and the natural character of the corridor, areas existing within the K-177 viewshed were excluded. Development in areas outside of the K-177 viewshed should be utilized first to maximize GMP planning efforts while allowing for a continued entrance experience that embodies the desired naturalistic character of the corridor (Figure 65 & 66).
Figure 65. Developer’s suitability with viewshed overlay
Figure 66. Conservationist’s suitability with viewshed overlay
Trail Suitability

Since a goal of the GMP is to promote multi-modal connectivity along and across the K-177 corridor (Riley County Kansas, 2011), a final analysis included the creation of a trail suitability model within GIS. The purpose of this model and resultant map is to show areas that offer the greatest potential for trail implementation while also expressing how the mapped existing trail network currently relates to the factors used for analysis. Five factors were used in the suitability model: slope, aspect, drainage networks, soils, and land cover (Figure 67). The same suitability ratings for drainage networks and aspect from the previous analysis were used while the other factors and their reclassifications are described in the following paragraph.

To minimize erosion and activity in areas of steeper grade, slope was reclassified in the GIS modelbuilder as: 0 – 6%, high suitability; 6 – 10%, moderate suitability; 10-15%, low suitability; 15%+, no development. Soil data was classified in accordance with the Riley County soil pathtrail classifications of not limited, somewhat limited, and very limited. Soils not limited to trail construction and under 10% were given a high suitability rating while soils with a not limited classification but between 10 – 15% slopes were deemed moderately suitable. Somewhat limited soils were given a low suitability rating while very limited soils represent areas of no trail development. To represent current vegetation and land use, the NLCD was once again used and reclassified. New suitability ratings were given to land cover types based on their ability to support trails and whether greenway principles could be applied to assist in preserving land and are expressed in the right column of Table 5.

By including the factors described above and setting an equal influence within the weighted overlay, the resultant map expresses the most suitable lands for trail construction (Figure 68). This map expresses the relationships between the existing trails and demonstrates how well they conform to mapped suitable areas. Illustrated through the suitability results, the current trails more or less follow ideal situations. A trail relationship map to public and private lands was then created to express areas zoned for public use (Figure 69). A primary route was selected by comparing the inventoried trails to the resultant suitability map. Secondary routes, or spur trails, offer limited access to other destinations. The total length of existing and potential connector trails are expressed in the Results chapter.

8. This suitability analysis represents potential trail routes. On-site trail routing will be necessary.
Figure 68. Trail suitability with mapped existing and potential trails

Legend
- - - - Existing Spur Trails
- - - - Existing Trails
Buildings
Roadways
Study Area
1120 Contour
Parcel Lines
0 - No Development
1 - Low Suitability
2 - Moderate Suitability
3 - High Suitability
Figure 69. Trail relationship to public and private lands.
The results are based on the 34 focus parcels described in the analysis of parcel selection. Total developable area within the focus parcels is 372.3 acres (ac), while the total developable area within the focus parcels and below the 1120 contour is 231 ac. The developer and conservationist results are followed by a discussion of trail suitability and the total mileage of existing primary, secondary, and potential trails.
Alternative 1 - Developer Approach

The results below express the total developable area from a developer’s approach. High and moderate development suitability is expressed in total acres below the 1120 contour and outside of the K-177 viewshed (Figure 70). Total land conserved and number of potential dwelling units densities is then given.

**Total Developable Area below 1120 Contour:**

High Development Suitability = 93 acres  
Moderate Development Suitability = 113 acres * 0.6666 = 75 acres

Total Land Conserved within Focus Parcels: 372.3 – 168 = 204.3 acres = 55%

Total Land Conserved within Study Area: 6,553 – 168 = 6,385 acres

Total Dwelling Units:  
High Development Suitability = 93 - 1023  
Moderate Development Suitability = 75 - 825

**Total Developable Area Outside Viewshed and below 1120 Contour:**

High Development Suitability = 37 acres  
Moderate Development Suitability = 54 acres * 0.6666 = 36 acres

Total Land Conserved within Focus Parcels: 372.3 – 73 = 299.3 acres = 80%

Total Land Conserved within Study Area: 6,553 – 73 = 6,484 acres

Total Dwelling Units:  
High Development Suitability = 37 - 407  
Moderate Development Suitability = 36 - 396

The 55% land conserved within the focus parcels is five percent short of project goal number 1, potential to conserve at least 60% of developable areas and lands within the study area. Such development patterns would remain consistent with conventional land zoning and development strategies (Figure 71 & 72). If development were to be restricted to areas outside the viewshed, 80 percent of land within the focus parcels could be conserved. These results suggest that an alternative plan must be considered if greater land conservation is required because developable areas outside the K-177 viewshed are limited.

9. Areas of moderate development were multiplied by .6666 to reflect 66-percent of the GMP’s (1-11) dwelling units per net acre. Based on the suitability ratings of high, moderate, low, and no development, a moderate development suitability would be 66-percent of the GMP desired dwelling units. Amount of development in areas representing moderate suitability should be further limited and discussed as development decisions are made.
Figure 70. Alternative 1 - Developer approach

Figure 71. Conventional zoning - Randall Arendt (http://www.dem.ri.gov)

Figure 72. Conventional development - Randall Arendt (http://www.landchoices.org)
Alternative 2 - Conservation Approach

The conservation approach results illustrate the total developable area. High and moderate development suitability is expressed in total acres below the 1120 contour and outside of the K-177 viewshed (Figure 73). Total land conserved and number of potential dwelling units densities is then given.

Total Developable Area Under 1120 Contour:

High Development Suitability = 51 acres
Moderate Development Suitability = 151 acres * 0.6666 = 101 acres

Total Land Conserved within Focus Parcels: 372.3 – 152 = 220.3 acres = 59%

Total Land Conserved within Study Area: 6,553 – 152 = 6,401 acres

Total Dwelling Units:  High Development Suitability = 51 - 561
Moderate Development Suitability = 101 - 1111

Total Developable Area Outside Viewshed and Under 1120 Contour:

High Development Suitability = 20 acres
Moderate Development Suitability = 73 acres * 0.6666 = 49 acres

Total Land Conserved within Focus Parcels: 372.3 – 69 = 303.3 acres = 81%

Total Land Conserved within Study Area: 6,553 – 69 = 6,484 acres

Total Dwelling Units:  High Development Suitability = 20 - 220
Moderate Development Suitability = 49 - 539

The 59% land conserved within the focus parcels is one percent short of project goal number 1, potential to conserve at least 60% of developable areas and lands within the study area. Such development patterns would reflect conservation designs presented by Randall Arendt (Figures 74 & 75). These development patterns combined with smaller lot sizes and setbacks would conserve an even greater total acreage than the results suggest, allowing goal number 1 to be satisfied and more protection to occur. If development were to be restricted to areas outside the viewshed, 81 percent of land within the focus parcels could be conserved. Development within areas outside of the K-177 viewshed and below the 1120 contour remain consistent through both approaches due to amount of developable area. Because development patterns from a conservationist approach would reduce lot sizes and setbacks, a greater total acreage of land conserved would result.
Figure 73. Alternative 2 - Conservationist approach

Figure 74. Conservation zoning - Randall Arendt (http://www.dem.ri.gov)

Figure 75. Conservation design - Randall Arendt (http://www.landchoices.org)
Trail Suitability

The results below express the total miles of primary, secondary, and potential trails. Potential trails were identified along suitable lands to connect and create a continuous trail network. The red potential trail to the south represents an alternative to minimize activity within sensitive areas.

Existing Primary Trails  =  22.8 miles or 21.6 miles (with existing trail in southern sensitive area removed)

Existing Secondary Trails  =  13.8 miles

Potential Trails  =  6.2 miles or 5.7 miles (with potential trail to south removed)

These primary, secondary, and potential trails meet the goals of the GMP by establishing multi-modal connectivity along and across K-177. These trails will connect development, protect remaining natural areas, and provide recreational opportunities for residents and visitors to the area. By providing such an amenity, it is hoped that reductions in vehicular emissions will be followed by an increase in environmental consciousness. Figures 76 - 79 express the character of several existing trails within the study area.
Trail Suitability (Figure 80)

Figure 80. Trail suitability
Chapter two developed alternative plans for development and expressed the total acreage of developable area, number of dwelling units as they relate to the GMP, and the level of conservation potential within the focus parcels. Because two alternative plans were created, it is now important to indicate how these different development strategies relate to previous development patterns within Manhattan, how they meet and deviate from the goals and objectives of the GMP, and what implications such approaches could mean for the future of the K-177 corridor. The importance of selecting a conservation approach, such as those presented in the precedent studies, is then discussed while explaining strategies that could be implemented to meet the goals of this study and the GMP.
Comparing Alternative Development Plans

Developer Approach

Alternative one, the developer’s approach, is the closest example to recent developmental patterns seen throughout Manhattan. By using this approach, development below the 1120 contour and along steeper slopes is maximized (orange and yellow) while the least amount of conservation is expressed (light green and dark green). To accommodate for such a high level of development and to meet current Manhattan and Riley County Zoning Regulations, construction costs and new infrastructure necessity is increased. Negative impacts to current drainage networks, soils, and vegetation communities can be expected because of an increase in construction operations and the amount of impervious surfaces adding to stormwater run-off. This also increases the likelihood of more habitat destruction, fragmentation, and degradation.

Similar development in Manhattan, such as the development adjacent to Wildcat Creek, has already shown that overdevelopment can have severe consequences to natural systems and existing habitat. Therefore, if all the goals and objectives of the GMP are to be met and such consequences avoided, an alternative plan must be considered. It is also critical that proper easements be set in place for development decisions to be limited in the future. As Julie Gustanski points out in her book, “The easements prohibit the uniquely American tendency to spread houses evenly across a landscape, a destructive, unsustainable practice that maximizes infrastructure cost, visual impacts, and short-term profits” (Gustanski, Squires, & Hocker, 2000, p. 113).
Conservationist Approach

Alternative two represents a development in terms of a conservationist’s set of values. Development through this approach would minimize construction on steeper slopes and further limit development in moderately suitable locations. Such development would minimize erosion potential, maintain or enhance water resources, and reduce the amount of vegetation clearing. While moderately suitable locations for development continue to exist outside of the drainage networks, maximizing development adjacent to the drainage networks would still increase pressures on current natural systems and habitats. To reduce this impact, limiting development to only one side of existing or potential roadways within areas offering less acreage is advisable, while subdivisions located in areas offering a larger total acreage could exist on both sides of the roadway. Further discussions pertaining to lot size, amount of clearing allowed by residents, and setback widths should be deliberated and/or amended if conservation priorities are set.

This alternative is closest to reflecting the goals and objectives of the GMP. Because no projected numbers of residential units, commercial businesses, or conservation area have been presented, this analysis provides a starting point for future discussions. I express the amount of development possible within and outside the viewshed, while also showing the total acreage of conservation potential. Again, since minimal developable acreage exists outside of the viewshed, decisions must be made as to the level of protection desired for scenic quality and views within the corridor. As planning continues and further community input is acquired, the GIS models can be altered to reflect various degrees of conservation and development priorities.

In addition, cluster ordinances, or limited development plans, could be placed on all development types to preserve greater areas of land. This would reduce the construction footprint and cost of new infrastructure, ultimately saving landowners, developers, and the city large sums of money. Other strategies, such as the use of conservation easements as discussed in the background chapter and Grannybelle Woods precedent study, could be set in place to limit future development. Possible easement plans for the preservation of lands adjacent to K-177 could include: native vegetation restoration, vegetation and land management, stream and drainage setback ordinances, protection of erosion prone areas, agriculture land protection, grazing land protection, parkland dedication, invasive species control, rare species protection, and transfer of development rights.

Conservation easements on privately owned lands have helped protect millions of acres of wildlife habitat and open space in the United States and in many other countries (Private Lands Conservation, 2013). Organizations that assist with such conservation easements within Kansas include: Kansas Department of Wildlife and Parks, Kansas Land Trust, The Nature Conservancy, Ranchland Trust of Kansas, and Kansas State University. Through the implementation of conservation easements, the resulting ecological, social, and economic benefits for private landowners can be substantial. The Nature Conservancy has provided examples of such benefits in their information page document entitled, “Conservation Easements: Conserving Land, Water and a Way of Life” (The Nature Conservancy, 2013) (Table 6).

Multiple housing types could be utilized to increase the overall number of dwelling units possible and reduce severe environmental impacts. The GMP defines these housing types as single family homes, duplexes, townhomes, and smaller apartment buildings existing outside the Commercial Core. Though development of single family homes, duplexes, and townhomes in areas defined as Urban Residential should be followed, it may be necessary for apartment buildings to be located within the Commercial Core area. Locating apartment buildings in this area could allow a higher density of residents. Apartment buildings could be built with additional stories while still protecting the scenic character of lands outside the Commercial Core.
## Conservation Easement Benefits

### Ecological Benefits

- Conserve watersheds and aquifers to provide clean water for public use
- Buffer treasured national parks such as Yellowstone from development and human activity
- Protect migratory corridors for wide-ranging animals
- Buffer other public lands such as military bases and national forests
- Protect and enhance the quality of life in rapidly growing urban and suburban areas
- Preserve agriculture, ranches, and timberlands

### Social Benefits

- Lands remain in private ownership with the landowner usually continuing to live on the property
- Protect targeted conservation values and meet specific landowner’s needs
- Allow for activities such as farming, ranching, and timber harvesting to continue under certain terms
  - Easement may require landowner to take certain actions to protect land and water resources, such as fencing a stream to keep livestock out
- Allow landowners to more easily pass on land to the children and grandchildren because a potential reduction in estate taxes may result from the conservation easement
- Easements remain with property even if land is sold or passed on to heirs, binding future landowners to the easement restrictions in perpetuity
- Help landowners fulfill their vision for the future of their lands and waters

### Economic Benefits

- Can result in lowered estate taxes, allowing heirs or new landowners more assistance in keeping the land intact while also saving money
- Lands restricted to agriculture often generate more in local revenues that they require in community services
- Extend conservation dollars by helping protect ecologically important lands, freeing limited funds for other conservation projects

---

Table 6. Ecological, social, and economic benefits of conservation easements (The Nature Conservancy, 2013)
The final goal of this research project is to provide multimodal connectivity along and across K-177. The resultant trail network meets the GMP’s objective of providing connections between potential areas of commercial development, residential neighborhoods, Fairmont Park, the Kansas River boat ramp, and downtown Manhattan. It also establishes connections to proposed developable areas and other significant destinations such as the K-177 Scenic Overlook, KS Hill, Konza Prairie, Lazy T Ranch, and various scenic ridgetops.

Another goal of this project is to express how these trails can incorporate greenway strategies to help further promote conservation initiatives while protecting and enhancing remaining natural areas. Thus, the next essential step is to develop conservation strategies for the existing and potential trails to show how this trail network can act as a “greenway.” Since it is difficult to determine the actual width of a greenway, evergreen locations, rare species, and protected areas can act as key starting points for greenway delineation (Figure 81).

Areas to the north, demonstrating a high percentage of evergreen vegetation, could be managed as part of the greenway plan to reflect the GMP’s objective of controlling eastern red cedar. Controlling the red cedar population will allow higher amounts of other native vegetation to thrive or be reintroduced, promoting healthier ecosystems and aiding in air and water quality. Rare species could also be protected as part of the greenway plan. By connecting usable patches through a greenway network, it is expected that fragmented plant and animal communities will have safer migration routes to increase the likelihood of biodiversity throughout the region.

Challenges

The greatest challenge in establishing a local greenway network for people, plants, and animals is providing safe connections across K-177. Establishing a crosswalk and stoplight at a major intersection, or further reducing speeds within the commercial core could make it less intimidating for pedestrians. Though effective, this strategy does not necessarily facilitate the other two users of the greenway as described above. Therefore, to accommodate all three user groups, I propose a constructed land bridge at one of four selected locations (Figure 82). This land bridge would not only aid safe travel across K-177 but would also create a “gateway” into Manhattan, a symbol that reflects strong conservation values developed in this study and as seen throughout the state. Figures 83 and 84 represent what character this land bridge might have.

Finally, this research suggests that the existing pedestrian pathway across the Kansas River could be expanded to facilitate an increased number of users. Expansion could involve the reduction of inbound traffic to one lane while outbound traffic remains two lanes. If two lanes of traffic in both directions is desired, expansion of the sidewalk should be no more than a suggested width of ten feet. An additional pedestrian connection across the Kansas River to Linear Trail is possible to the north (Figure 85). A pedestrian bridge may be effective in this location due to the presence of existing utility easements(10).

The conclusions and strategies discussed in this chapter ultimately seek to further the goals and objectives of the GMP while being a platform for future conservation and development decisions. The results of this study will increase the ability of current stakeholders to determine the level of conservation needed to support development while conserving natural systems. Before these strategies can be effectively utilized, it is important that a desired amount of development be established. Deciding development numbers will allow for different scenario assessments within the GIS models to be created. These alternative plans will help to form conservation priorities before development begins.

10. The pedestrian bridge is mentioned strictly to generate ideas for development and design potential. Expansion of the Kansas River Bridge sidewalk should be considered first before any other locations are discussed.
Figure 81. Trail suitability, protected areas, rare species relationships
Figure 82. Land bridge and pedestrian bridge potential

- Zeandale Rd.
- Acorn Ln.
- Lafayette Drive
- Road Elevation begins to descend
- Pedestrian Connection to Linear Trail

Figure 83. Vancouver land bridge (http://laud8.wordpress.com)

Figure 84. Florida land bridge (http://www.americantrails.org)

Figure 85. Concrete Stress Ribbon - Redding, California (http://www.americantrails.org)
Assessment of Study Goals

The following section restates study goals and explains how the results have attempted to meet these goals. The results have helped advance the efforts of the GMP and established a platform for decision making. As conservation and development decisions progress, these goals will continue to help guide future land use decisions.

Ecological Goals

1. Show potential to conserve at least 60% of developable areas and lands within the study area

Alternative two conserves 59 percent of the lands within the focus parcels. If development were restricted to these parcels, the total conservation of lands within the site boundary would be approximately 99 percent or greater. These plans conform to the goals and objectives of the GMP while also allowing a significant amount of development to exist within the study area.

2. Identify contiguous habitat for native plant and animal species

Through the development suitability analysis, lands most suitable for development existing outside the major drainage networks were located. If these suitable areas were utilized for their development potential, while lands within close proximity to current drainage networks were minimally developed or left unaltered, effects to the riparian corridors, habitat, and the overall watersheds would be reduced. Selected greenway locations also offer additional protection by acting as buffers to development and providing alternative modes of transportation. Accompanied management plans could be used to control red cedar vegetation and reintroduce herbaceous vegetation. Also, by restricting development on the ridgetops, native grasslands will continue to thrive while providing safe migration routes for animals.

3. Retain corridor’s scenic appeal and natural character

The viewshed analysis revealed that there are only a few northern and southern parcels that present significant development opportunities outside the K-177 viewshed and below the 1120 foot elevation. Clustering development in these locations would maximize the number of units possible while adhering to the GMP’s strategies to protect the corridor’s naturalistic character. Height restrictions and other design guidelines could be applied to the remaining developable lands within the focus parcels and existing inside of the corridor’s visible area. Additionally, this architecture could be combined with well-planned landscaping and planting to provide screening for new development after construction has taken place. Greenway locations that connect new and old development will also help to enhance the viewshed and naturalistic character by protecting the ridgelines and drainage networks where most woody vegetation is present.

4. Conduct a preliminary assessment for future conservation initiatives

The results have shown the most sensitive locations that should be protected within the study area. Identifying these locations helps landowners become aware of the conservation opportunities within or adjacent to their property, or areas that should be monitored. This awareness can help create community goals dedicated to conservation, allowing landowners to see themselves as part of a much larger system. As conservation goals are discussed and established, it will remain important for landowners to work together with private land trusts to preserve land for future generations.
Social Goals

1. Show potential for a greenway network of active and passive recreation to connect development, historic destinations, culturally unique areas, scenic vistas, and other significant open space.

This greenway network would provide a public amenity while also helping to protect remaining natural lands within the site boundary and extending into the local Flint Hills. As Randall Arendt states in his book, *Rural by Design*, property values can actually increase as a result of open space provisions within and around development (Arendt, 1994). As subdivisions are zoned and developed, the greenway can continue to grow and connect development, provide links to significant destinations, increase environmental consciousness, and protect wildlife habitat.

2. Provide suitability maps and precedents to inform landowners on the structure, use, and benefits of conservation easements.

This study has not only delineated potential conservation areas, it has also articulated how conservation easements have been used to produce a number of positive benefits. By presenting this information, it is hoped that all landowners become aware and concerned with the future development of their property and its environmental integrity. Through the use of such easements, a greater ability to protect lands from overdevelopment can result while increasing the likelihood for these lands to remain privately owned.

Economic Goals

1. Advance the efforts of the Gateway Plan through identifying developable areas.

By locating suitable lands for development within and outside of the K-177 viewshed, showing conservation potential, and providing solutions for multi-modal connectivity, the results meet and advance the goals of the GMP. Again, these results will continue to provide assistance to landowners, developers, conservationists, and city planning boards for making educated development decisions. For such plans to be enacted, it is crucial that on-site assessments be conducted within these spatially defined locations before development/construction begins.

2. Identify opportunities for monetary tax incentives and increases in local revenue.

As The Nature Conservancy has pointed out, agriculture lands can help produce more local revenue if left intact (The Nature Conservancy, 2013). Greenways can also help to reduce public costs and produce public revenue by eliminating unfavorable development and attracting desirable development. This new development can create jobs while generating local revenue from property taxes (Little, 1990). The proposed greenway has the ability to generate additional local revenues by creating tourism opportunities. Connections could be made to the Flint Hills Discovery Center that would allow visitors on-site educational experiences of the Flint Hills region.

3. Identify developable areas that require minimal earthwork to reduce upfront construction costs.

Locating suitable lands where gentle slopes are present can lead to lower construction costs; the need for new infrastructure is also reduced. This will save landowners and the city funds as development takes place. Siting development in these locations will also help to protect erosion prone soils, water resources, and sensitive habitats.
Greenway Planning

Greenways offer a number of benefits: exercise, social interaction, nature observation, stormwater filtration, habitat for wildlife and plant species, and can be located along existing rights-of-way. Therefore, they are becoming extremely popular within the design, planning, and conservation professions (Arendt, 1994). According to Charles Little’s book *Greenways for America*, modern-style greenways have been around for years but citizen movements to create them have not been prevalent until most recently (Little, 1990).

Since most of the lands existing within the study area are under private ownership, citizen-led groups and interested landowners will need to work together to foster common goals for conservation and development within their properties. This research can not only educate landowners, conservationists, and developers within the area about potential future strategies, but also adds to body of knowledge for landscape architecture and related fields by providing criteria for assessing greenway feasibility as it relates to development and conservation.

Conservation Planning and Landscape Ecology

The necessity for effective conservation planning is continuing to grow as remaining natural lands transform into other land use types. Also, in the past decade, landscape architecture has seen a great shift towards a more ecological approach to planning that strives to integrate both landscape processes as well as landscape patterns at multiple scales. As landscape architects and planners seek to provide sustainable design solutions and environments for the future, conservation planning and landscape ecology will become an even greater part of research, design, decision making, and the planning process.

Land use projections in this study have identified lands within the study area as being potential locations for residential and commercial development. With Manhattan’s population increasing each year, it will become an even greater challenge to protect undeveloped lands in the future if restrictions for development are not set. By showing the conservation, developmental, and recreational opportunities of these lands, I hope to promote the establishment of a greenway network in conjunction with conservation and development decisions.
Further Research

As stated throughout this document, this research is meant to advance the goals and objectives of the GMP, establish a platform for decision making, and act as a stepping stone to further research. The results spatially locate conservation and potential developable areas within the study area at a major entry into Manhattan, Kansas. To further this research it is recommended that assessments of current drainage networks, soil capabilities, and habitat communities be conducted.

Understanding the amount of water moving through current drainage networks, water quality, and how much recharge is occurring will allow for projections to be made as to the amount of development that can exist without damaging water resources and habitats. Resisting development in areas of sensitive or important soils could allow for more water percolation and limit the amount of sediment transported to other locations. More precise mapping of existing habitats will facilitate more specific conservation and developable areas. The results will find gaps in potentially fragmented habitat, allowing strategic plans and greenway connections to be established to promote linkages between these habitats.

To make the goals of this project and the GMP attainable, proposed designs, construction estimations, and economic projections will be needed. Proposed development design and new roadways should seek to utilize developable areas and conform to existing topography as closely as possible. Construction should be strategically planned to minimize compaction of soils, earthwork operations, and amount of clearing required. These construction factors combined with other sensitive approaches to construction, such as restricting the turning radius of heavy equipment, would minimize overall cost and environmental impacts to natural systems. Economic projections will show how resulting development will affect landowners, new residents to the area, and the local community.

The elements discussed in the previous paragraph could be more easily understood by using design, construction, and graphic software to produce construction documents and visually express such designs. In the Wildwood Estates design project discussed earlier in this document, I used AutoCad Civil 3D to plan for developable sites and locate potential road alignments. This process showed the amount of earthwork needed to accommodate project goals (Figure 86). A three-dimensional model was created using GIS and Vue 9.5 xStream of site topography, existing vegetation, and design elements to show the development character (Figure 87). Similar processes to estimate area needed to develop or where new roadways should exist to connect development within the study area should be used to allow greater understanding of future development plans(11).

Potential roadways to the resultant developable areas and to areas on the ridgetops existing outside of the K-177 viewshed are shown in Figure 88 on page 91. Road alignments should be further studied inside the potential developable areas to establish more specific and cost effective routes. Potential roadways to ridgetop areas should also be studied to see if such limited development warrants the cost of constructing this new infrastructure. Though development in these areas is possible, I advise against such development due to the existence of native herbaceous vegetation on the ridgetops. This vegetation is important for water resources and is already being threatened by other factors, such as invasive species. Another reason to not develop on the ridgetops is attributed to the shallow limestone layers that would increase the cost of foundations for housing.

Finally, additional viewshed studies will be important to understand how development can be seen from other entrances into Manhattan and other significant destinations. High elevations along the proposed greenway network have been mapped to express potentially critical views (Figure 89). Greenway viewpoints and their resulting viewshed area will remain important to further protect scenic views and enhance opportunities to experience the natural character of the corridor.

11. These software applications and their use are further discussed in the Supplemental Files and Programs section of this document.
Figure 86. Wildwood Estates development, roadway, and earthwork plan using AutoCAD Civil 3D

Figure 87. Wildwood Estate entrance view looking south using VUE 9.5 xStream
Figure 88. Potential development and ridgetop roads
Figure 89. Trail suitability and critical viewpoints
Works Cited


NRCS. (1975). *Soil Survey of Riley County and Part of Geary County, Kansas*.


Figure Sources

Figure 1

Figure 2

Figure 3

Figure 4

Figure 5

Figure 6

Figure 7

Figure 8

Figure 9

Figure 10

Figure 11

Figure 12

Figure 13

Figure 14

Figure 15

Figure 16

Figure 17
Figure 18

Figure 19

Figure 20

Figure 21

Figure 22

Figure 23

Figure 24

Figure 25

Figure 26

Figure 27

Figure 28

Figure 29

Figure 30
Farley, Joshua. 2013. Literature Map. InDesign

Figure 31

Figure 32

Figure 33

Figure 34
Figure 35

Figure 36

Figure 37

Figure 38

Figure 39

Figure 40

Figure 41

Figure 42

Figure 43

Figure 44

Figure 45
Farley, Joshua. 2013. Methodology diagram. InDesign

Figure 46

Figure 47
Figure 48

Figure 49

Figure 50

Figure 51

Figure 52

Figure 53

Figure 54

Figure 55
Farley, Joshua. 2013. Rare species and protected areas. Source data: KansasGIS. “Roadways 2010,” “Rare species,” “Protected areas.” Riley County GIS. “Buildings,” “Prairie Chicken area.” ArcGIS 10.1.

Figure 56

Figure 57

Figure 58

Figure 59

Figure 60

Figure 61
Farley, Joshua. 2013. Conservationist Values. InDesign

Figure 62

Figure 63
Figure 64

Figure 65

Figure 66

Figure 67

Figure 68

Figure 69

Figure 70

Figure 71

Figure 72

Figure 73

Figure 74

Figure 75

Figure 76

Figure 77

Figure 78
Figure 79

Figure 80

Figure 81

Figure 82

Figure 83

Figure 84

Figure 85

Figure 86
Farley, Joshua. 2011. Wildwood Estates development, roadway, and earthwork plan. AutoCAD Civil 3D.

Figure 87

Figure 88

Figure 89

Figure 90

Figure 91

Figure 92
Appendices
Appendix A - Ecotourism - Annotated Bibliography
In her book, Honey highlights the key characteristics of ecotourism and describes that since its growth in the mid-1980’s,

“ecotourism has hailed as a panacea: a way to fund conservation and scientific research, protect fragile and pristine ecosystems, benefit rural communities, promote development in poor countries, enhance ecological and cultural sensitivity, instill environmental awareness and a social conscience in the travel industry, satisfy and educate the discriminating tourist, and, some claim, build world peace” (Honey, 1999, p. 4).

She describes ecotourism as a truly nature based tourism that extends far beyond the simple “greenwashing” of an industry. With a growing concern for the environment and desires to have outdoor travel, a substantial market for ecotourism has grown and is becoming ever prevalent in the way people travel today. Thus, to be real ecotourism, the author establishes these following seven characteristics as a must:

1. Involves travel to natural destinations
2. Minimizes Impact
3. Builds environmental awareness
4. Provides direct financial benefits for conservation
5. Provides financial benefits and empowerment for local people
6. Respects local culture
7. Supports human rights and democratic movements

(Honey, 1999)

Honey later stresses that marketing remains one of the most important tools for ecotourism, with ineffective strategies as potentially being the primary reason why several ecotourism ventures fail. By finding the right market and creating mechanisms that retain a greater profit, local communities can use these proceeds to fund conservation and economic development projects.

Relevance to Project

To establish ecotourism as an option for landowners and provide incentive to preserve undeveloped lands south of the Kansas River along K-177, it is imperative that such an operation meets the guidelines stated in Honey’s book, while also marketing to select groups and types of travelers. This research and design project demonstrated the opportunities present for a greenway network to exist. A further opportunity to utilize this greenway to develop a networked based ecotourism operation amongst private landowner’s within the area is possible.

Important Quotations

“Properly defined, then, ecotourism is travel to fragile, pristine, and usually protected areas that strives to be low impact and (usually) small scale. It helps educate the traveler: provides funds for conservation: directly benefits the economic development and political empowerment of local communities: and fosters respect for different cultures and for human right” (Honey, 1999, p. 25).

“Ecotourism demands a more holistic approach to travel, one in which participants strives to respect, learn about, and benefit both the environment and local communities” (Honey, 1999, p. 24).

“Ecotourism promotes locally owned enterprises, but with globalization and free trade, weak national capital often cannot compete with strong foreign companies” (Honey, 1999, p. 86).

“Some of the most successful ecotourism projects are tied to scientific research stations, working farms, or fishing communities where there are several sources of income” (Honey, 1999, p. 91).
In this book, Fennell focuses his attentions on recreational programming and planning, stating that these two elements "provide the necessary ingredients for the development of well conceived recreation and tourism experiences" (Fennell, 2002, p. 66). The programming model Fennell applies to his book stems from previous books on recreational programming, constructing it as followed: needs and assets, programme a (structure), programme b (gearing up to go), programme c (leadership and risk), implementation, and evaluation. Though each category is discussed in detail and remains important, I will be considering the needs and assets, programme a (structure), implementation, and evaluation for this literature review.

The needs assessment is ‘the process by which the program planner identifies and measures gaps between what is and what ought to be’ (Windsor et al., 1994, p. 63; see also Gilmore and Campbell, 1996). By collecting data through a social, economic, and physiographic perspective, the programmer can begin to evaluate what activities people or groups of people would participate in while also locating areas of suitability/feasibility that provide unique resources, attractions, and destinations.

Programme a (structure), integrates both science and art into the programme, allowing for educational experiences of natural history and culture. These elements range from decisions regarding outdoor recreation activities, types of lodging, and incorporation of trails and trail types. “The programmer should endeavor to construct a matrix of different programme alternatives in order to decide objectively on a programme that is truly reflective of the resources and competencies of the service provider” (Fennell, 2002).

Features of the implementation stage from Fennell’s programming model include programme life cycle, marketing, quality, staff training, public relations, budgeting, implementation strategies, and schedules and itineraries (Fennell. 2002). Every product or programme element may pass through stages of a life cycle that begins with product development, followed by product introduction, growth, and finally product decline.

To effectively market an ecotourism operation, one must establish marketability in terms of product, price, place, and promotion. Gaining this understanding as well as being thoughtful of consumer needs will permit a sound marketing tool to attract visitors and keep them coming back.

The final stage of the programme model is the evaluation stage, which may be formative, occurring during programme development and implementation, or summative, information leading to decisions about continuation, termination, expansion, or adoption. “Evaluation should not be viewed as a special function to be employed in difficult times, but rather as part of the programme cycle” (Fennell, 2002, 218). By evaluating possible solutions and existing outcomes, the programmer can begin to conceptualize positive design strategies to meet client needs before a project begins and into the future.

Relevance to Project

By utilizing Fennell’s model, an organized framework is established that will allow for educated and informed program decisions. These decisions, backed by assessments of social, economic, and environmental characteristics, will provide a structure by which a networked based ecotourism operation could exist. Such an operation and coordination between landowner’s could continue to provide educational and recreational opportunities for the residents of Manhattan and visitors traveling to the area.

Important Quotations

“Maintaining open lines of communication between stakeholders is critical in developing successful local ecotourism industries” (Fennell, 2002, p. 59).

“...a systematic compilation of attractions and resources that occur within a tourism destination region, and which will help to demarcate the spatial and temporal boundaries of the ecotour” (Fennell, 2002, p. 102).

“However, developing the structure of the ecotourism programme should not stop with areas and formats for the simple reason that ecotourism occurs in many remote areas, involves many different types of activities, relies on a number of different forms of transportation, and often requires an overnight stay component” (Fennell, 2002, p. 11).
Appendix B - Technical GIS Analysis
Development Suitability Analysis

Slope

- Dem > Spatial Analyst Tools > Surface > Slope > Input = Dem
- Output > Slope
- Spatial Analyst > Reclass > Reclassify
  - 0%-5% = 3
  - 5.01%-8% = 2
  - 8.01%-20% = 1
  - 20.01% = 0

ArcHydro for Drainage Networks and buffer distance

- From DEM 2 meter > Fill Sink
- Flow Direction
  - Input DEM > Flow Direction Grid (FDR)
- Flow Accumulation
  - Input > FDR
  - Output > Flow Accumulation Grid
- Stream Definition
  - Input > Flow Accumulation Grid > # of cells (5000, 500, 50)
  - Output > Stream Grid
- Stream Segmentation
  - Input > FDR, Stream Grid
  - Output > Stream Link Grid (SLG)
- Drainage Line Processing
  - Input > SLG, FDR
  - Output > Drainage Lines for (5000, 500, 50 cell grid)

Buffer to Raster

- Analysis Tools > Proximity > Buffer > Input = each 5000, 500, 50 Stream Grids
- Buffer distance in linear feet = 66’
- Output > buffers for each drainage line type-5000, 500, 50
- Open Attribute Table > Add Field FlowAC_Type > Start Editor > add 50 in area below FlowAC_Type
  - do the same for the 500 cell and 5,000cell buffers as well
- Dissolve each buffer by FlowAC_Type
- Merge > 50, 500, 5,000 buffers on same layer
- Conversion Tools > To Raster > Feature to Raster > Output = stream raster
- Spatial Analyst > Reclass > Reclassify > 5000 cell (0), 500 cell (1), 50 cell (2), All other data (3)

Utilities

- Analysis Tools > Proximity > Buffer > Input = water and sewer lines
- Buffer distance = 16 feet
- Analysis Tools > Overlay > Union
- Input = water and sewer line buffers
- Output = utilities buffer
- Conversion Tools > To Raster > Feature to Raster
- Spatial Analyst Tools > Reclass > Reclassify
  - 16 ft buffer = 0 (no development)
  - All other data = 3 (developable)
Soils Suitability
- Open Attribute Table > Add Field = Suit_Rate
- Turn on Editor > Add Value >
  - 0-6 - 3 Note: soils having a 6 value but representing a poorly suited site prep were given a suitability value of 2
  - 6-10 - 2
  - 10-15 - 1
  - 15+ - 0
- Conversion Tools > To Raster > Feature to Raster > Input = Soils > Field = Suit_Rate
- Output > soils raster

Aspect
- Dem > Spatial Analyst Tool > Input = Dem
- Output > Aspect
  - Spatial Analyst > Reclass > Reclassify
  - 0 - 34.392136 - 1
  - 34.392136 - 69.784272 - 1
  - 69.784272 - 105.176408 - 2
  - 105.176408 - 141.984229 - 3
  - 141.984229 - 178.79205 - 3
  - 178.79205 - 214.184186 - 3
  - 214.184186 - 250.992008 - 3
  - 250.992008 - 287.799829 - 2
  - 287.799829 - 323.191965 - 1
  - 323.191965 - 359.999786 - 1
  - NoData NoData
- Output > Aspect_Suitability = 1,2,3

Land Cover
- NLCD > Open Attribute Table > Add Field > Suit_Rating > 0,1,2,3
- Right Click > Properties > Symbology > Unique Values > Value Field = Suit_Rating
- Spatial Analyst > Reclass > Reclassify > Input = NLCD > Field = Suit_Rating
- Output > Land Cover Raster

Table B.1. Development land cover suitability ratings
Developer Suitability Weighted Overlay

- Spatial Analyst > Weighted Overlay
- Input suitability rasters for conservation approach > utilities, slope, drainage networks
- Evaluation Scale = 0 to 3 by 1
- Equal Influence given to each factor = 33% Note: 34% given to drainage networks because no rational #'s
- Output > Developer Suitability

Conservationist Suitability Weighted Overlay

- Spatial Analyst > Weighted Overlay
- Input suitability rasters for conservation approach > utilities, slope, aspect, drainage networks, soils, land cover
- Evaluation Scale = 0 to 3 by 1
- Influence > utilities (10%), slope (20%), aspect (10%), drainage networks (30%), soils (10%), land cover (20%)
- Output > Conservationist Suitability

Trail Suitability

Drainage Networks

- 5000 cell – 0-development
- 50 cell – 1-low suitability
- All other data-3-high suitability

Slope

- 0-6% = 3, high suitability
- 6-10% = 2, moderate suitability
- 10-15% = 1, low suitability
- 15+ = 0, no development

Aspect

- Same as development suitability

Soils

- Classified in terms of pathtrail from Riley County Soils
  - Not limited under 10% = 3, high suitability
  - Not limited between 10-15% = 2, moderate suitability
  - Somewhat limited = 1, low suitability
  - Very limited = 0, no development
Land Cover

- NLCD > Open Attribute Table > Add Field > Suit_Rating > 0, 1, 2, 3

<table>
<thead>
<tr>
<th>Land Cover</th>
<th>Suitability Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Water</td>
<td>0</td>
</tr>
<tr>
<td>Developed, Open Space</td>
<td>3</td>
</tr>
<tr>
<td>Developed, Low Intensity</td>
<td>3</td>
</tr>
<tr>
<td>Developed, Medium Intensity</td>
<td>3</td>
</tr>
<tr>
<td>Developed, High Intensity</td>
<td>3</td>
</tr>
<tr>
<td>Barren Land</td>
<td>3</td>
</tr>
<tr>
<td>Deciduous Forest</td>
<td>1</td>
</tr>
<tr>
<td>Evergreen Forest</td>
<td>3</td>
</tr>
<tr>
<td>Mixed Forest</td>
<td>2</td>
</tr>
<tr>
<td>Shrub/Scrub</td>
<td>3</td>
</tr>
<tr>
<td>Herbaceous</td>
<td>3</td>
</tr>
<tr>
<td>Hay/Pasture</td>
<td>3</td>
</tr>
<tr>
<td>Cultivated Crops</td>
<td>2</td>
</tr>
<tr>
<td>Woody Wetlands</td>
<td>0</td>
</tr>
<tr>
<td>Emergent Herbaceous Wetlands</td>
<td>0</td>
</tr>
</tbody>
</table>

Table B.2. Trails land cover suitability ratings

- Right Click > Properties > Symbology > Unique Values > Value Field = Suit_Rating
- Spatial Analyst > Reclass > Reclassify > Input = NLCD > Field = Suit_Rating
- Output > Land Cover Raster

Trail Suitability Weighted Overlay

- Spatial Analyst > Weighted Overlay
- Input suitability rasters for trails > drainage networks, slope, aspect, soils, major powerlines, protected areas, rare species, land cover
- Evaluation Scale = 0 to 3 by 1
- Equal Influence given to each factor
- Output > Trail Suitability
Developer Values GIS Model

Figure 90. Developer values GIS model

Conservationist Values GIS Model

Figure 91. Conservationist values GIS model
Trail Suitability Model

Figure 92. Trail suitability GIS model
Stream Raster -> Reclassify -> Stream Reclass -> Weighted Overlay -> Trail Suitability
Appendix C - Contacts and Associated Organizations
Contacts

Contacts

1. Steve and Mary Springer

Initial contact with Steve and Mary Springer, landowners within the area, was established in the fall of 2011 through LAR 648 as previously discussed. Communication and research was conducted through client meetings, guided tours of the property, site inventory, analysis, and design development using GIS and graphic based software’s. Mr. and Mrs. Springer demonstrated a great enthusiasm for the project, and their willingness to allow students on the property whenever they wished was granted through phone calls and scheduling. Mr. Springer has stated that he and his wife are still interested in development opportunities but any future plan for their property has yet to be established.

2. Brian Obermeyer – The Nature Conservancy

I have contacted and explained the details of my project with Brian Obermeyer, Landscape Programs Manager and Director of the Conservancy’s Flint Hills Initiative at The Nature Conservancy. The purpose of this communication was to generate preliminary interests for the project and discuss potential strategies for future conservation initiatives within the region. For ten years, Mr. Obermeyer has worked with ranchers, landowners, and other stakeholders to preserve more than 36,000 acres to conservation easements within the Flint Hills (The Nature Conservancy, 2013). Continued contact with Mr. Obermeyer will allow a real world perspective on the steps needed to implement conservation strategies as well as offer insights and recommendations for project results or specific questions that may present themselves.
Associated Organizations

1. The Nature Conservancy

The Nature Conservancy is a conservation organization that works around the world to protect our remaining natural areas and water resources. The Conservancy remains the largest conservation organization in the state of Kansas and has helped protect over 95,000 acres of tallgrass prairie, wetlands, mixed-grass prairie, and short-grass prairie since 1989. Working with universities, other land trusts, and private landowners, the conservancy continues to develop its ability to protect lands quickly and efficiently. Some examples of these protected areas include: Tallgrass Prairie National Preserve, Konza Prairie, Flint Hills Tallgrass Prairie Preserve, Flint Hills Initiation, Anderson County Prairies, Red Hills Initiative, Cheyenne Bottoms, and Smoky Valley Ranch. For more information regarding The Nature Conservancy’s mission or for additional details specific to projects located throughout Kansas and the rest of the United States, please refer to the Conservancy’s website at www.nature.org (The Nature Conservancy, 2013).

2. Kansas Land Trust

The Kansas Land Trust is a nonprofit organization that works to conserve natural ecosystems, farm and ranch lands, and scenic open spaces that are vital in maintaining the environmental and economic well-being of Kansans. The land trust works with landowners throughout Kansas by assisting in protection strategy decisions that reflect the landowner’s conservation and financial needs while also taking the responsibility to legally enforce the agreed upon restrictions. Though there are several strategies for preserving land, most strategies involve the donation of a conservation easement to the land trust that places protective restrictions on future land use.

Easements have been used to protect wildlife habitat, wetlands, riparian areas, prairies, open space, farmland, scenic vistas, and recreational corridors. They have also been used as a developmental strategy by allowing a landowner to develop portions of their property while dedicating the remaining lands as natural or cultural resources. It is also important to note that public access to the land is not required by the Kansas Land Trust but may be permitted for educational or scientific purposes (Kansas Land Trust, 2012).
3. Kansas Department of Wildlife and Parks

The Kansas Department of Wildlife and Parks is a public steward to the state’s natural resources while recognizing that fish, wildlife, and outdoor recreation are important to the quality of life for all Kansans and the Kansas economy. The Department seeks to conserve and enhance Kansas’s natural heritage and resources, provide the public with opportunities for use and appreciation of these resources through a conservation framework, and educate the public on the current resource status. By facilitating public awareness and understanding of environmental related issues through conservation, the Department hopes to generate public support towards its mission to provide for future generations (KWDP, 2012).

4. Ranchland Trust of Kansas

The Ranchland Trust of Kansas, an affiliate of the Kansas Livestock Association, is yet another organization that strives to help protect remaining natural areas throughout the state. In addition to establishing a model for conservation easements and successfully protecting 5,276 plus acres of land in Kansas, the RTK has also participated in informative sessions to educate attendants on the basics of conservation easements and private agricultural land trusts. Other notable achievements include the securing of state funding for conservation easements through Kansas legislative action and the creation of a stewardship endowment fund that helps provide financial support for the monitoring and enforcement of perpetual conservation easements (RTK, 2012).

5. Kansas State University

The Konza Prairie, an 8,600 acre preserve located in the Flint Hills region of northeastern Kansas, is jointly owned by Kansas State University and The Nature Conservancy. Kansas State University Division of Biology helps to operate the prairie by conducted field research of the existing ecosystems and wildlife habitats. These operations not only help to preserve lands within the Konza Prairie, but also seek to provide solutions for the protection of other tallgrass areas and sensitive environments throughout the state. Additional funding and research programs could be achieved through Kansas State University involvement to increase the potential for further land preservation initiatives within the K-177 corridor.